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INTRODUCCION

Macromedia Dreamweaver es un editor de cédigo HTML profesional
para el disefio visual y la administracion de sitios y paginas Web. Tan
si prefiere controlar manualmente el cédigo HTML como si prefiere
trabajar en un entorno de edicion visual, Dreamweaver le permite
ponerse manos a la obra radpidamente y le facilita herramientas utiles
para mejorar su experienciaen disefio Web.

Las funciones de edicidn visual de Dreamweaver también le permiten
afiadir disefio y funcionalidad rdpidamente sin escribir una sola linea
de codigo. Puede ver todos los elementos o activos del sitio y
arrastrarlos desde un panel facil de usar directamente hasta un
documento. Agilice su flujo de trabajo de desarrollo mediante la
creacion y edicion de imagenes en Macromedia Fireworks y su
importacion directa a Dreamweaver, o bien afladiendo objetos Flash
gque puede crear directamente en Dreamweaver.

Dreamweaver se puede personalizar totalmente. Utilice Dreamweaver
para crear sus propios objetos y comandos, modificar métodos
abreviados de teclado e incluso escribir codigo JavaScript para
ampliar las posibilidades que ofrece Dreamweaver con nuevos
comportamientos, inspectores de propiedades e informes de sitios.

Administracion del Sitio

Un sitio Web es un conjunto de documentos vinculados con atributos
compartidos, tales como temas relacionados, un disefio similar o un
objetivo comun.

Macromedia Dreamweaver es una herramienta de creacion y
administracion de sitios, por lo que puede utilizarla para crear sitios
Web completos, ademéas de documentos individuales. Para obtener
resultados 6ptimos, disefie y planifique el sitio Web antes de crear las
paginas que va a contenerel sitio.

2 Creacion del sitio

Una vez que cree la estructura del sitio, debera establecer el nuevo
sitio en Dreamweaver. Establecer este sitio local en Dreamweaver
significa que puede utilizar Dreamweaver con FTP para cargar el sitio
en el servidor Web, para controlar y mantener automaticamente los
vinculos y para compartir archivos con otras personas que colaboren
con usted. Lo mas adecuado es configurar el sitio local en
Dreamweaver antes de comenzar a crear las paginas.
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2.1 Sitio local

El sitio local es la estructura del sitio que usted establece en el equipo
para que contenga todas las carpetas, activos y archivos de un sitio
concreto.

La carpeta raiz local del sitio deberé ser especifica de ese sitio. Una
buena idea es crear una carpeta llamada Sitios y, posteriormente,
crear carpetas raiz locales dentro de esa carpeta, una para cada sitio
con el que trabaje.
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El paso siguiente a la hora de configurar un sitio remoto consiste en
determinar donde se va a situar el sitio, es decir, qué servidor lo
albergara. Su cliente, suempresa o su proveedor de servicios Internet
(ISP) disponen probablemente de un servidor configurado para
albergar paginas Web (Internet o intranet). Pregunte al administrador
del sistema o a su cliente el nombre de dicho servidor y como se
realizan las transferencias de archivos.

En particular, averigte si se utiliza FTP para conectar con el servidor
0 si puede montar el servidor como una unidad de disco con acceso de
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red desde su escritorio. Si conecta utilizando FTP, averigue el nombre
del servidor FTP y determine el directorio del servidor, asi como la
informacion de conexion y de contrasefia.

Después de crear un sitio local, use el comando Definir sitios para
afladir o cambiar la informacidn del servidor remoto asociado y las
preferencias de desproteccion/ proteccidn.

Para asociar un servidor remoto a un sitio local existente:

1 Elija Definir sitios en el menu emergente de sitios actuales de la
ventana Sitio, o bien elija Site > Editsites

2 Aparecerda un cuadro de dialogo con los sitios definidos actualmente.
Seleccione un sitio existente y haga clic en Editar.

Si no dispone de sitios definidos actualmente, cree un sitio local antes
de continuar.

3 En lalista Categoria de laizquierda, haga clic en Datos remotos.

4 Elija una de las siguientes opciones de Acceso al servidor:

«Utilice Ninguno si no tiene previsto cargar el sitio en un servidor. A
continuacién, haga clic en Aceptar y omita el resto de este
procedimiento.

«Utilice Local/red si el servidor Web estd montado como unidad de red
(Windows) o como servidor AppleTalk o NFS (Macintosh), o si lo esta
ejecutando en el equipo local. Haga clic en el icono de carpeta para
localizar y seleccionar la carpeta del servidor donde se almacenan los
archivos. Si desea que el panel Remoto de la ventana Sitio se actualice
automaticamente a medida que se afladan y borren archivos,
seleccione la opcion Actualizar lista archivos remotos autom. Para
aumentar la velocidad de transferencia de archivos al sitio remoto,
deje esta opcion desactivada. Para actualizar manualmente la ventana
Sitio en cualquier momento, haga clic en el boton Actualizar de dicha
ventana. Haga clic en Aceptary omita el resto de este procedimiento.

Utilice FTP si se conecta con el servidor Web a través de FTP.

Instituto de Computacion Activa de México S. C. 6



MACROMEDIA DREAMWEAVER MX

Para conectar con un servidor Web mediante FTP:

1 Introduzca el nombre del servidor FTP en el que cargara los
archivos del sitio Web. EI nombre del servidor FTP es el nombre
completo en Internet de un sistema informatico, como
ftp.mindspring.com. Introduzca el nombre completo del servidor sin
texto adicional. Sobre todo, no afiada un nombre de protocolo delante
del nombre del servidor. Porejemplo:

Correcto: ftp.mindspring.com

Incorrecto: ftp://ftp.mindspring.com

Incorrecto: mindspring.com

2 Introduzca el nombre del directorio del servidor del sitio remoto
donde se almacenan los documentos visibles para el publico.

3 Introduzca el nombre de conexion y la contrasefia que utiliza para
conectar con el servidor FTP.

Dreamweaver guarda la contrasefia de forma predeterminada.
Desactive Guardar si prefiere que el sistema le solicite la contrasefa
cada vez que conecte con el servidor remoto.

4 Seleccione las opciones deseadas de cortafuegos para el sitio:

Active la opcion Usar cortafuegos si conecta con el servidor remoto
desde el otro lado de un cortafuegos. Para obtener méas informacion
sobre las opciones de cortafuegos.

Si su configuracion de cortafuegos requiere el uso de FTP pasivo (que
permite que el software local configure la conexion FTP en lugar de
solicitarselo al servidor remoto), seleccione Utilizar FTP pasivo. Si no
esta seguro, consulte al administrador del sistema.

5Haga clic en done.

3 CREACION DE UNA PAGINA NUEVA

Macromedia Dreamweaver ofrece diversas formas de crear un
documento. Puede crear documentos HTML nuevos y vacios; abrir un
documento HTML existente, aunque no haya sido creado con
Dreamweaver; o bien crear un nuevo documento basado en una
plantilla.

También puede abrir archivos de texto no HTML, como archivos
JavaScript, archivos de correo electronico de texto normal o archivos
de texto guardados con procesadores de texto o editores de texto. No
podra utilizar todas las herramientas de edicién de documentos de
Dreamweaver en un documento de texto normal, pero si podra utilizar
funciones béasicas de edicion de texto. Entre las posibles razones para
abrir un documento de texto figuran editar y depurar cdédigo
JavaScript, consultar el contenido del archivo de configuracion de
Dreamweaver o abrirun correo electrénico que contiene un fragmento
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de cédigo HTML para copiarel cdédigo y pegarlo en otro documento.

Para crear un documento HTML vacio en una nueva ventana de
documento, realice una de estas operaciones:

En la barra de de menus elija

File> new> create, se abre un cuadro de dialogo en el cual le permite
escoger uno de las tantas hojas de trabajo.

Si abre la vista de Codigo (en la ventana de documento) o el inspector
de cddigo, podra ver que el nuevo documento no esta totalmente
vacio, pues contiene etiquetas html, head y body para que pueda
comenzar a trabajar. Mientras escriba en la vista de Disefio de la
ventana de documento o inserte objetos tales como tablas e imagenes,
podra dejar abierto un editor de codigo y observar como se crea el
coédigo HTML. Para obtener mas informacion sobre los editores de
codigo.

Para abrir un archivo HTML existente, lleve a cabo una de estas
operaciones:

«Seleccione File > Open.

+Si el archivo se ha creado con Microsoft Word, elija File > Import >
Word HTML

Si elige Importar HTML de Word, Dreamweaver abre el archivo y le
permite especificar opciones para eliminar cddigo ajeno a HTML
generado por Word. (Microsoft Word 97 y las versiones posteriores
cuentan con el comando Guardar como HTML, que afiade codigo
HTML innecesario al convertir un documento a este formato.) Para
obtener mas informacion.

Nota: No se puede importar directamente un archivo de Microsoft
Word (.doc) a Dreamweaver. Si desea importar el contenido de un
archivo de Word, inicie Word y guarde el archivo como HTML antes de
importar el archivo HTML resultante a Dreamweaver.
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Para guardar un documento:
1 Seleccione File > save as.

2 Proporcione un nombre para el archivo y vaya hasta el lugar en el
que desea guardar el archivo.

Nota: Dreamweaver afiade automaticamente .htm (Windows) o .html
(Macintosh) al nombre del archivo cuando aparece el cuadro de
didlogo. (Puede controlar la extension de archivo que debe afiadirse
utilizando una opcion de las preferencias generales.) Para guardar un
archivo como texto normal en Windows, asignele la extension de
nombre de archivo .txt. Para guardar un archivo como texto normal en
Macintosh, sencillamente borre .html del nombre del archivo
Macintosh. (Para que Dreamweaver vea el archivo como HTML de
nuevo, guardelo otra vez con la extension .html o .htm.) Después de
guardar un archivo como texto, Dreamweaver no interpreta ningun
coédigo HTML del archivo.

Cuando guarde los documentos, evite utilizar espacios y caracteres
especiales en los nombres de archivos y carpetas siempre que sea
posible. En concreto, no utilice caracteres especiales (como é, ¢ 0 ¥)
ni signos de puntuacién (como dos puntos, barras inclinadas o puntos)
en los nombres de archivos que desee colocar en un servidor remoto;
muchos servidores cambian estos caracteres durante la carga, lo que
provoca que se rompan los vinculos existentes con los archivos.
Asimismo, no comience los nombres de los archivos con numeros.

3 Haga clic en el botdn Guardar para guardar el archivo.

4. PANEL DE PROPIEDADES (PROPERTIES)
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El panel de propiedades o properties le permite corregir las
caracteristicas de un elemento seleccionado en la pagina, tal como
texto o algun objeto insertado.

La mayoria de los cambios que usted realice a las caracteristicas se
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aplican inmediatamente en el documento sin embargo los cambios no
se solicitan asta que usted hagaclic en objeto ya sea texto oimagen.
El contenido del panel de properties varia en los tipos de objetos

seleccionados.
Para mas informacidn de alguna caracteristica especifica selecciona

el objeto y en la esquina superior derecha del panel de properties
haga clic en el icono de signo de interrogacion.

para mostrary ocultar el panel de properties
vaya a la barra de menu

seleccione Windows>properties
También puede abrirla con lacombinacién de teclas CTRL + F3

5. CONFIGURAR PAGINA (PROPERTIES,
BACKGROUND, LINKS, TEXT)
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Dreamweaver le permite trabajar en su documento de diferentes
formas: utilizando la vista Disefio, utilizando la vista Coédigo o
empleando una vista combinada que muestra el disefio y el cddigo del
documento. Puede cambiar la vista en la que desea trabajar
seleccionando wuna vista en la barra de herramientas de

Dreamweaver.
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Conforme cree y trabaje con los documentos, Dreamweaver generara
automaticamente el codigo HTML subyacente. Para examinar o editar
este cdédigo, utilice uno de los editores de cédigo de Dreamweaver: la
vista de Cddigo de la ventana de documento o el inspector de cédigo.
La vista de Disefio de Dreamweaver muestra una representacion
visual del documento, en lugar del cdédigo subyacente. Cuando trabaje
en la vista de Disefio, podra optar entre dos vistas para realizar el
disefo: vista de Disposicidn o vista Estandar. Puede seleccionar estas
vistas en el panel Objetos, bajo Ver.

En la vista de Disposicion, puede disefiar una disposicion de pagina e
insertar graficos, texto y otros elementos multimedia.

asonegtrl. - Utilice el cuadro de didlogo Propiedades de la pagina para especificar
ara abrir las diversas opciones de la pagina. Para abrir el cuadro de dialogo
)ple_dadesde Propiedades de la pagina, elija Modify >page properties o presione la
Scullle siguiente combinacién CTRL + J.

Title especifica el titulo de la pagina que aparece en la barra de titulo
de la ventana de documento y la ventana de la mayoria de los
navegadores.

Background image y Background especifican una imagen y un color

de fondo para la pagina.

Text y Links definen los colores predeterminados de texto, vinculos,
vinculos visitados y vinculos activos. También puede controlar estos
colores utilizando hojas de estilos CSS.

Leftmarginy Top Margin especifican los tamafios de los margenes de
la pagina en la etiqueta body para Microsoft Internet Explorer
solamente. Netscape Navigator prescinde estos valores y utiliza los de
margin width y margin height. Para obtener un resultado 6ptimo en
los dos navegadores, proporcione valores de margenes para ambos
navegadores en lugar de para uno solo; complete los cuatro valores de
margenes en lugar de so6lo dos. Para asegurarse de que no aparecen
margenes en ningun navegador, configure los cuatro valores con el
valor 0. Dreamweaver no muestra margenes de pagina en la ventana
de documento. Utilice Vista previa en el navegador para ver los
margenes.

Document Encoding. Especifica la codificacion empleada para los
caracteres del documento. Para inglés y otros idiomas de Europa
Occidental, elija Occidental. Otras opciones posibles son:
centroeuropeo, cirilico, griego, islandés, japonés, chino tradicional,
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chino simplificado y coreano. Si no aparece ninguna opcion para la
codificacion que desea utilizar, elija Otro para crear un documento
con la codificacion que use su sistema operativo. Todos los idiomas
asiaticos utilizan codificacion de doble byte.

Para cambiar las fuentes que emplea Dreamweaver para mostrar
cada codificacion, elija Edit > Edit with external editor y seleccione
Fuentes/codificacion. Las fuentes que seleccione en este panel de
preferencias Fuentes/codificacion no afectaran al modo en que los
visitantes ven las paginas, ya que éstos especifican sus propias
fuentes (para una determinada codificacion) en los navegadores Web.
Para obtener més informacion.

Tracing iamge especifica una imagen que se va a emplear como guia
para copiar un disefio. Esta imagen so6lo sirve como referencia, ya que
no aparece cuando el documento se muestra en un navegador.

Image transparency determina la opacidad de la imagen de rastreo,
desde completamente transparente hasta completamente opaca.

Document folders. Muestra la carpeta en la que se guarda el
documento actual, si ha sido guardado.

Site foldrs muestra la ruta de la carpeta raiz local del sitio en la que se
ha guardado el documento actual, en el caso de que se haya guardado.

6 CREACION DE HIPERVINCULOS
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Utilice el panel de properties y el icono de sefializacion de archivo
para crear vinculos desde una imagen, un objeto o texto hasta otro
documento o archivo.

Para crear vinculos entre documentos utilizando el icono de carpeta o

el cuadro de texto Vinculo:
1 Seleccione texto o una imagen en la vista de Disefio de la ventana de
documento.
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2 Abra el panel de properties (Windows > properties) y lleve a cabo
una de estas operaciones:

+«Haga clic en el icono de carpeta situado a la derecha del campo Link
paralocalizar y seleccionar un archivo.

La ruta del documento vinculado aparecerd en el campo URL. Utilice
el menu emergente Relativo a del cuadro de dialogo Seleccionar
archivo HTML para indicar si la ruta es relativa al documento o a la
raiz. Acontinuacion, hagaclic en Seleccionar.

Nota: Al cambiar el tipo de ruta en el campo Relativo a, Dreamweaver
utilizard esta selecciéon como el tipo de ruta predeterminado para
futuros vinculos hasta que la cambie.

«En el campo Vinculo, introduzca la ruta y el nombre de archivo del
documento. Para establecer un vinculo con un documento del sitio,
introduzca una ruta relativa al documento o relativa a la raiz. Para
establecer un vinculo con un documento externo al sitio, introduzca
una ruta absoluta que incluya el protocolo (por ejemplo, http://).
Puede utilizar este sistema para introducir un vinculo para un archivo
que aun no se ha creado.
3 Seleccione una ubicacion para abrir el documento.
Para que el documento vinculado aparezca en un lugar distinto de la
ventana o el marco actual, seleccione una opcion en el menu
emergente Destino del inspector de propiedades:
« blank carga el documento vinculado en una nueva ventana sin
nombre del navegador.

« parentcargael documento vinculado en el marco o la ventana padre
del marco que contiene el vinculo. Si el marco que contiene el vinculo
no estd anidado, el documento vinculado se cargara en la ventana
completa del navegador.
+ self carga el documento vinculado en el mismo marco o la misma
ventana que el vinculo. Este destino es el predeterminado, por lo que
normalmente no es preciso especificarlo.

« top carga el documento vinculado en la ventana completa del
navegador, eliminando de esta forma todos los marcos.

Sugerencia: Si todos los vinculos de la pagina se estableceran con el
mismo destino, puede especificar este destino una vez eligiendo
Insert > Head tangs >Base y seleccionando la informacién de
destino.

Para obtener informacion sobre el establecimiento de vinculos con
marcos. Para crear un vinculo con un documento utilizando el icono
de sefializacion de archivo:

1 Seleccione el texto o una imagen en la vista de Disefio de la ventana
de documento.
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2 Arrastre el icono de sefializacidon de archivo situado a la derecha del
campo Vinculo en el panel de properties y sefiale otro documento
abierto, un punto de fijacion visible en un documento abierto o un
documento de la ventana Sitio. El campo Vinculo se actualizara para
mostrar el vinculo.
Nota: El documento abierto o el archivo de la ventana Sitio al que
sefiale pasard a un segundo plano en la pantalla mientras realiza la
seleccion.

3 Libere el botén del ratén.

Para crearun vinculo desde una seleccion en un documento abierto:

1 Seleccione texto en la vista de Disefio de la ventana de documento.

2 Presione mayus. y, al mismo tiempo, arrastre la seleccion.

Mientras arrastra la seleccién, aparecera el icono de sefializacién de
archivo.

3 Seflale otro documento abierto, un punto de fijacion visible en un
documento abierto o un documento de la ventana Sitio.

4 Libere el boton del ratén.

Para crear un vinculo utilizando el mapa del sitio y el icono de
sefializacion de archivo:

1 En la ventana Sitio, active las vistas Archivos del sitio y Mapa del
sitio presionando el icono Mapa del sitio mientras elige Mapa y
archivos.

2 Seleccione un archivo HTML del mapa del sitio.
Aparecera el icono de sefializacion de archivo junto al archivo.

3 Arrastre el icono de sefalizacion de archivo y sefiale otro archivo del
mapa del sitio o un archivo local de la vista Archivos del sitio.

4 Libere el boton del raton.

Se colocard un vinculo de hipertexto con el nombre del archivo
vinculado en la parte inferior del archivo HTML seleccionado. Este
meétodo ofrece buenos resultados para crear vinculos rapidamente en
un sitio que se esta creando.

7 INSERCION DE IMAGENES
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Al insertar una imagen en un documento de Dreamweaver, el
programa genera automaticamente una referencia al archivo en el
codigo HTML. Para asegurarse de que esta referencia es correcta, el
archivo de imagen debera estar en el sitio actual. Si no lo est4,
Dreamweaver le preguntara si desea copiar el archivo en la carpeta
raiz.

Para insertarunaimagen:

1 Lleve a cabo una de estas operaciones:

«Sitle el punto de insercion en el lugar de la ventana de documento
donde desea que aparezca la imagen y, a continuacion, elija Insert >
Image o haga clic en el boton Insertar imagen de la categoria
Common del panel Objetos.

«Sitle el punto de insercion en el lugar de la ventana de documento
donde desea que aparezca la imagen y, a continuacion, presione
Control+Alt+1 (Windows).

sArrastre el boton Insertar imagen desde el panel Objetos hasta la
posicion deseada de la ventana de documento.

«Arrastre unaimagen desde el panel Activos hasta la posicidén deseada
de la ventana de documento. Acontinuacion, siga con el paso 3.
sArrastre una imagen desde la ventana Sitio hasta la posicion deseada
de la ventana de documento. Acontinuacidn, siga con el paso 3.
sArrastre una imagen desde el escritorio hasta la posicion deseada de
la ventana de documento. Acontinuacion, siga con el paso 3.

2 En el cuadro de diadlogo que aparece, haga clic en Examinar para
elegirun archivo o escriba la ruta del archivo de imagen.

Si estd trabajando en un documento que no estd guardado,
Dreamweaver generara una referencia de archivo:// al archivo de
imagen. Al guardar el documento en el sitio, Dreamweaver convierte
la referencia en una ruta relativa al documento.
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3 Definalas propiedades de laimagen en el panel de PROPERTIES.
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Cuestionario 1

1.- Definicion de una pagina Web

2.- Definicion de un Sitio

3.- Definicidon de un portal

4.- Definicidon de un Sito Local y Remoto

5.- Paquete que instala C:\inetpub\wwwroot

6.- Que es el IIS y para que sistema operativo

7.-Que es el PWSY para que sistema operativo

8.- Definicidn de Hipervinculo

Instituto de Computacion Activa de México S. C. 17



MACROMEDIA DREAMWEAVER MX

WVWWV.ICAMCOMITX
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CAPITULO 2
Al final del capitulo el alumno sera capaz de...

Insertar interactivos

Insertar imagenes de sustitucidn

Crear barras de navegacion

Insertar botones de flash

Insertar texto flash

Insertar objetos HTML Fireworks

Comprueba tu avance y marca con una g los objetivos alcanzados

8. INSERCION DE INTERACTIVOS
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Una imagen de sustitucion es una imagen que cambia cuando el
puntero pasa sobre ella. Una imagen de sustitucion consta en realidad
de dos imagenes: la imagen principal (la que aparece al cargarse
inicialmente la pagina) y la imagen de sustitucion (la que aparece al
pasar el puntero sobre la imagen principal). Ambas imégenes deben
tener el mismo tamafio. Si tienen tamafios distintos, Dreamweaver
cambia automaticamente el tamafio de la segunda imagen para que se
ajuste a las propiedades de la primera.
Las imagenes de sustitucion estan configuradas de manera
predeterminada para responder al evento MouseOver. Para obtener
informacion sobre la configuracién de una imagen para que responda
a otro evento (por ejemplo, un clic del ratén) o sobre la edicion de una
imagen de sustitucion para que muestre otra imagen.

Una forma mas compleja de imagen de sustitucion es la barra de
navegacion. Para crear una barra de navegacion, utilice Insert >
Interactive Image> Navigation bar.

Para crearunaimagen de sustitucién:

1 En la ventana de documento, sitie el punto de insercion en el lugar
donde desea que aparezca laimagen de sustitucién.

2 Introduzca laimagen de sustitucion mediante uno de estos metodos:
+En la categoria Common del panel Objetos, haga clic en el icono
Insertar imagen de sustitucidn.

«En la categoria Common del panel Objetos, arrastre el icono Insertar
imagen de sustitucion hasta la posicion deseada de la ventana de
documento.

«Elija Insert>Interactive Images >Rollovers Image.

Aparecera el cuadro de dialogo Insertarimagen de sustitucion.

3 En el campo Image Name, introduzca un nombre para la imagen de
sustitucion.

4En el campo Imagen original, haga clic en Examinar y seleccione o
escriba la ruta de la imagen que desea mostrar cuando se cargue la
pagina.

5 En el campo Rollover Image, haga clic en Examinar y seleccione o
escriba la ruta de laimagen que desea mostrar cuando el puntero pase
sobre laimagen original.

6 Si desea precargar las imagenes en la caché del navegador de modo
gue se carguen mas rapidamente, seleccione la opcion Carga previa
de imagenes.

7 En el campo when clicked, go to URL, haga clic en browse y
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seleccione o escriba la ruta del archivo que desea abrir cuando un
usuario hagaclic en laimagen de sustitucion.

Nota: Si no establece un vinculo para la imagen, Dreamweaver
insertard un vinculo nulo (#) en el codigo HTML relativo al
comportamiento de sustitucién. Si elimina el vinculo nulo, la imagen
de sustitucién dejaré de funcionar.

8Haga clic en Aceptar para cerrar el cuadro de dialogo Insertar
imagen de sustitucion.

8.1 ROLLOVER IMAGE

Insert Rollover Image
Tmage Mame: | R

ddal

Original Image: | Browese.... |
Rclower Image: | Browse.,
W Ereload Rolover Image
Atennate Teat: |
Wehan Chickesd, Gor To URL: | Browee. ..

Un rolloveriamge es unaimagen de sustitucion que en el momento de
pasar el mouse cambia
Para un rolloverimage siga las siguientes instrucciones:

1 En la ventana de documento, sitde el punto de insercion en el lugar
donde desea que aparezca laimagen de sustitucion.

2 Introduzca laimagen de sustitucion mediante uno de estos metodos:
+En la categoria Common del panel Objetos, haga clic en el icono
Insertar imagen de sustitucidn.

+En la categoria Common del panel Objetos, arrastre el icono Insertar
imagen de sustitucion hasta la posicion deseada de la ventana de
documento.

«Elija Insert>Interactive Images >Rollovers Image.

Aparecera el cuadro de dialogo Insertarimagen de sustitucion.

3 En el campo Image Name, introduzca un nombre para la imagen de
sustitucion.

4En el campo Imagen original, haga clic en Examinar y seleccione o
escriba la ruta de la imagen que desea mostrar cuando se cargue la
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pagina.

5 En el campo Rollover Image, haga clic en Examinar y seleccione o
escriba la ruta de laimagen que desea mostrar cuando el puntero pase
sobre laimagen original.

6 Si desea precargar las imagenes en la caché del navegador de modo
gue se carguen mas rapidamente, seleccione la opcion Carga previa
de imagenes.

7 En el campo when clicked, go to URL, haga clic en browse y
seleccione o0 escriba la ruta del archivo que desea abrir cuando un
usuario hagaclic en laimagen de sustitucion.

Nota: Si no establece un vinculo para la imagen, Dreamweaver
insertard un vinculo nulo (#) en el codigo HTML relativo al
comportamiento de sustitucion. Si elimina el vinculo nulo, la imagen
de sustitucién dejaréd de funcionar.

8Haga clic en Aceptar para cerrar el cuadro de dialogo Insertar
imagen de sustitucién.

8.2 NAVIGATION BAR

Jwp_Lempact Home Pags - Meomolt Inkzinst E g

| frbe Dacke e Pewatts eawssnia A | | Dieesin [ 0 achean de paogearati secadt s e T e Congar_Siave Cones
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F THIE PLANNER r' DERTINATIIME = TRAVEL LOGSH

Un navigation bar se compone de una imagen o un conjunto de
imagenes cuya visualizacion cambia segun las acciones que realiza el
usuario. Los navigation bar permiten desplazarse facilmente entre las
paginas y los archivos de un sitio.
Antes de insertar un navigation bar, cree un conjunto de imagenes
para los estados que se mostrardn con cada elemento de navegacion.
Un elemento de navigation bar se puede considerar como un botén, ya
que la hacerclic en él, lleva al usuario a otra pagina.

Un elemento de navigation bar puede tener cuatro estados:

+«Up image: laimagen que aparece cuando el usuario aun no ha hecho
clicenelelemento o interactuado con él. Por ejemplo, parece como si
no se hubiera hecho clic en el elemento que se encuentra en este
estado.

= DESTINATIONS

« Over image: la imagen que aparece cuando el puntero se mueve
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sobre la imagen. Cambia la apariencia del elemento (por ejemplo,
puede aparecer mas claro) para indicar a los usuarios que pueden
interactuar con él.

P~ DESTINATIONS

«Down image: la imagen que aparece después de hacer clic en el
elemento. Por ejemplo, cuando un usuario hace clic en un elemento,
se carga una nueva pagina y la barra de navegacion sigue
mostrandose, pero el elemento en el que se ha hecho clic aparece
oscurecido para indicar que se ha seleccionado.

+«Over while down image: la imagen que aparece cuando el puntero
pasa sobre la imagen Abajo después de haber hecho clic en el
elemento. Por ejemplo, el elemento puede aparecer atenuado o gris.
Puede utilizar este estado para indicar visualmente a los usuarios que
no pueden volver a hacer clic en el elemento mientras se encuentren
en esta parte del sitio.

No es necesario incluir imagenes de barra de navegacidon para los
cuatro estados. Por ejemplo, es posible que s6lo necesite los estados
Arriba y Abajo.

Puede crear una barra de navegacion, copiarla en otras paginas del
sitio, utilizarla con marcos y editar los comportamientos de la pagina
para mostrar distintos estados a medida que accede a las paginas

8.3 FLASH BOTTON

Sarvm b [baboni vt L“E:.J
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El objeto de flash botton permite personalizar e insertar un conjunto
de botones Flash predisefiados.

Nota: Deberd guardar el documento antes de insertar un objeto de
boton 0 de texto Flash.

Para insertar un objeto de Flash Botton:

1 Mientras se encuentra en la vista de Disefio de la ventana de
documento, seleccione media en panel de objetos y presione el boton
Insertar Flash botton en el panel Objetos o elija Insert > Interactive
images >Flash botton. También puede arrastrar el icono de Flash
botton sobre la ventana de documento.

Aparecera el cuadro de didlogo Insertar botdén Flash.

2 Seleccione el estilo de boton que desee en la lista Style.

Vera un ejemplo del botén en el campo Muestra. Puede colocar el
ratbn encima de la muestra para ver como funciona en el navegador.
Sin embargo, el campo Muestra no se actualiza automaticamente para
mostrar los cambios realizados en el texto o la fuente. Estos cambios
apareceran en la vista de Disefio.

3 En el campo botton text (opcional), escriba el texto que desea
mostrar.

Porejemplo, escriba Presione aqui Este campo s6lo acepta cambios si
el boton seleccionado tiene un parametro {Button Text} definido. Esto
se puede observar en el campo Muestra. El texto que escriba
reemplazara {Button Text} cuando previsualice el archivo.

4 En el campo Font, especifique un tamafo de fuente y seleccione la
fuente que desea utilizarel ment emergente.

S6lo es necesario realizar selecciones de fuente y tamafio si el boton
tiene parametros de texto definidos. Si la fuente predeterminada de un
boton no esta disponible en el sistema, seleccione otra fuente en el
menud emergente. Tenga en cuenta que no vera la fuente seleccionada
en el campo Muestra, aunque puede hacer clic en Aplicar para
insertar el botén en la paginay ver qué apariencia tendra el texto.

5 En el campo Link (opcional), introduzca un vinculo absoluto o
relativo al documento para el botén.

No se admiten vinculos relativos al sitio porque los navegadores no los
reconocen en las peliculas Flash. Si utiliza un vinculo relativo al
documento, guarde el archivo SWF en el mismo directorio que el
archivo HTML. Los navegadores interpretan los vinculos relativos al
documento de distintas formas y, por tanto, al guardar los vinculos en
el mismo directorio se garantiza su correcto funcionamiento.

6 En el campo target (opcional), especifigue un marco o una ventana
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de destino para cargarel vinculo del boton Flash.

7 En el campo Bg color (opcional), establezca el color del fondo de la
pelicula Flash. Utilice el selector de colores o escriba un valor
hexadecimal para la Web (como # FFFFFF).

8 En el campo save as, introduzca un nombre de archivo para guardar
el nuevo archivo SWF.

Puede utilizar el nombre de archivo predeterminado (por ejemplo,
buttonl.swf) o escribir uno nuevo. Si el archivo contiene un vinculo
relativo al documento, debera guardarlo en el mismo directorio que el
documento HTML actual para mantener los vinculos relativos al
documento.

9 Haga clic en Get more styles para pasar al sitio Macromedia
Exchange y descargar maés estilos de botdn.
Para obtener més informacion.

10 Haga clic en Apply o presione OK para insertar el boton Flash en la
ventana de documento.

Sugerencia: Seleccione Aplicar para ver los cambios realizados en la
vista de Disefio. Mientras mantiene el cuadro de dialogo abierto
puede continuar realizando cambios en el botdn.

Para modificar un objeto de Flash botton:
1 En lavista de Disefo, seleccione el objeto de Flash botton.

2 En el panel de properties mostrara las propiedades del Flash botton.
Puede realizar cambios en el panel de properties. Estos cambios
modifican los atributos HTML como ancho, altoy color de fondo.

3 Para realizar cambios en el contenido, muestre el cuadro de dialogo
Insertar Flash botton utilizando uno de estos métodos:

s«Haga doble clic en el objeto de Flash botton.

sHaga clic en Editen el panel de properties.

«Haga clic con el boton derecho (Windows) o mientras presiona la
tecla Control (Macintosh)y elija Editen el mena contextual.

4 En el cuadro de dialogo Insert Flash botton, edite los campos
descritos en el procedimiento anterior.

En la vista de Disefio, puede cambiar el tamafio del objeto facilmente
utilizando los manejadores de cambio de tamafio. Puede restablecer
el tamafio original del objeto seleccionando Restablecer tamaifo en el
inspector de propiedades.

Para ver como se reproduce el objeto de Flash botton en la ventana de
documento:

1 En lavista de Disefo, seleccione el objeto de Flash botton.
2 En el panel de properties, haga clic en el botén verde Reproducir.
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3 Hagaclic enel botdon rojo Detener para terminar la previsualizacion.
Nota: No se puede editar el objeto de Flash botton mientras se esta
reproduciendo.

Conviene previsualizar siempre el documento en el navegador para
comprobar exactamente la apariencia que tendra el botén Flash.

8.4 FLASH TEXT
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El objeto de Flash text permite crear e insertar una pelicula Flash que
s6lo contiene texto. Esto permite crear una pequefia pelicula de
graficos vectoriales con fuentes de disefio y el texto que elija.

Para insertar un objeto de texto Flash:

1 Mientras se encuentra en la vista de Disefio de la ventana de
documento, seleccione media en panel de objetos y presione el boton
Flash text en el panel Objetos o elija Insert >interactive images >
Flash Text.

Aparecera el cuadro de dialogo Insertar texto Flash.

2 Seleccione una fuente en el menu emergente Font.
Este mend muestra todas las fuentes TrueType cargadas actualmente
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en el sistema.
3 Introduzca un tamafio de fuente (de puntos)en el campo Size.

4 Especifique los atributos de estilo, como negrita o cursiva, y la
alineacion del texto haciendo clic en los botones del estilo
correspondiente.

5En el campo Color, establezca el color del texto utilizando el selector
de colores o introduciendo un valor hexadecimal para la Web (como
#FFFFFF).

6 En el campo Rollover color, establezca el color que aparece cuando
el puntero pasa sobre el objeto de texto Flash. Utilice el selector de
colores o escriba un valor hexadecimal para la Web (como #FFFFFF).

7 Introduzca el texto deseado en el campo Texto.
Para ver el estilo de fuente que se muestra en el campo Texto, active
la casilla que dice show font.

8 Si desea asociar un vinculo con el objeto de Flash text, introduzca un
vinculo absoluto o relativo al documento en el campo link.

No se admiten vinculos relativos al sitio porque los navegadores no los
reconocen en las peliculas Flash. Si utiliza un vinculo relativo al
documento, guarde el archivo SWF en el mismo directorio que el
archivo HTML. Los navegadores interpretan los vinculos relativos al
documento de distintas formas y, por tanto, al guardar los vinculos en
el mismo directorio se garantiza su correcto funcionamiento.

9 Si ha introducido un vinculo, puede especificar un marco o una
ventana de destino para cargarese vinculo en el campo Target.

10 En el campo Bg color, elija un color de fondo para el texto. Utilice el
selector de colores o escriba un valor hexadecimal para la Web (como
#FFFFFF).

11 En el campo save as, introduzca un nombre para el archivo.

Puede utilizar el nombre de archivo predeterminado (por ejemplo,
texl.swf) o escribir uno nuevo. Si el archivo contiene un vinculo
relativo al documento, deberd guardarlo en el mismo directorio que el
documento HTML actual para mantener los vinculos relativos al
documento.

12 Haga clic en Apply o presione el boton OK para insertar el Flash
texten la ventana de documento.

Si hace clic en Apply, el cuadro de diadlogo permanecera abierto y
podra previsualizar el texto en el documento.
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8.5 HTML FIREWORKS
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Dreamweaver permite insertar codigo HTML generado por Fireworks,
completo con imagenes asociadas, divisiones y JavaScript, en un
documento. Esta caracteristica de insercion facilita la tarea de
agregar tablas o mapas de imagenes creados en Fireworks en un
documento de Dreamweaver.

Para insertar codigo HTML de Fireworks en un documento de
Dreamweaver:

1 En Dreamweaver, guarde el documento en un sitio definido.

2 Coloque el punto de insercion en el documento donde desee que
comience el codigo HTML insertado.

3 Siga uno de estos procedimientos:

«Seleccione Insert> Interactive Images > Fireworks HTML.

«Haga clic en el botdon Insertar Fireworks HTML de la categoria
Common del panel Objetos.

4 En el cuadro de dialogo que aparece a continuacion, haga clic en
Browse para seleccionar el archivo HTML de Fireworks que desee.

5 selecciones la casilla de opcion delete file after insertion para
desplazarel archivo HTML a la Papelera de reciclaje (Windows).
Utilice esta opcidon en caso de no necesitar el archivo HTML de
Fireworks después de insertarlo. Esta opcion no afecta al archivo PNG
origen asociado con el archivo HTML.
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Nota: S el archivo HTML se encuentra en una unidad de red, se
elimina de forma permanente, no se desplaza a la Papelera de
reciclaje o Papelera.

6 Haga clic en OK para insertar el cédigo HTML, junto con sus
imagenes, divisiones y JavaScript asociados, en el documento de
Dreamweaver.
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Cuestionario 2

1.- Definicién de barra de navegacion

2.-Opcion que permite interactuar con fireworsk

3.-Un Hipervinculo creado en fireworsk puede ser
modificado en dreamweaver

Falso () verdadero ()
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CAPITULO3

Al final del capitulo el alumno sera capaz de...

Configurar el navegador

Editar unalista de navegadores

Conocer labarradeinsert

Utilizar la fichacommon

Comprueba tu avance y marca con una g los objetivos alcanzados
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9. CONFIGURACION DEL NAVEGADOR A TRABAJAR
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Vista previa usando el servidor local Permite elegir un servidor local
para realizar la vista previa de una pagina en un navegador (sélo
Windows). Para que esta opcién funcione es necesario ejecutar
software de servidor en el ordenador local. Cuando esta opcidn esta
activada, Dreamweaver suministra la pagina actual para realizar la
vista previa en un servidor local como un URL que comienza por
http://localhost/. Cuando esta opcion estd desactivada, Dreamweaver
abre el documento en un navegador con una ruta de archivo que
comienza por archivo://. En algunos casos, los vinculos especificados
como rutas relativas a la raiz no funcionan correctamente cuando se
abren en un navegador con una ruta archivo://. Lo mismo sucede

cuando se lleva a cabo la comprobacion de un navegador de destino.

esione F12 ) _ . _

raver la El boton de signo mas (+) aflade un navegador a la lista.

sta previade , . - .

pagina Web El boton de signo menos (-) elimina el navegador seleccionado en la

lista.
Editar cambia la configuracion del navegador seleccionado.

Navegador principal y Navegador secundario especifican si el
navegador seleccionado es el principal o el secundario. Presione F12
para abrir el navegador principal o F12 (Windows).
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9.1 EDITAR LISTA DE NAVEGADORES

Dreamweaver permite crear paginas Web con elementos que admiten
todos los navegadores (por ejemplo, imagenes y texto de parrafo), asi
como con elementos que s6lo admiten los navegadores mas recientes
(porejemplo, estilos y capas).

La funcion Comprobar navegadores de destino analiza el HTML de los
documentos para ver si hay etiquetas o atributos que no admiten los
navegadores de destino. La comprobacion no altera el documento.

Para ejecutar una comprobacion del navegador de destino:

1 Dispone de las opciones siguientes:

«Para ejecutar la comprobacion en el documento actual, guarde el
archivo. La comprobacion se realizara con la dltima versién guardada
del archivoy no incluira los cambios que no haya guardado.

«Para ejecutar la comprobacién con un directorio o un sitio, elija
Windows>Site y abra la ventana FTP del sitio. A continuacién,
seleccione una carpeta en el directorio local. La comprobaciéon del
navegador de destino se realizara en todos los archivos HTML de esa
carpeta y las subcarpetas que contenga. La comprobacion del
navegador de destino s6lo se puede llevar a cabo con archivos locales.

2 Elija File > Preview in Browser.
Si aun no ha seleccionado un Explorador principal, el programa le
pedira que lo haga.

3 En la lista de navegadores, seleccione el navegador de destino que
desea utilizar para la comprobacion del sitio.

4 Para guardar el informe, elija File > save en el navegador.
Las preferencias de Vista previa en el navegador muestran los
navegadores principal y secundario definidos actualmente. Para abrir
las preferencias de Vista previa en el navegador, elija File > preview
in browser >lexplore, o bien oprima F12
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10 FICHAS INSERT
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El panel de insert contiene botones I[lamados fichas insert que sirven
para la creacion e insercion de diversos tipos de objetos, como tablas,
capas e imagenes.

10.1 COMMON (IMAGE, RELLOVER, TABLE, NAVIGATION BAR,
HORIZONTAL BAR, DATE, OBJEST,FLASH, FIREWORKS, GENERATOR,
BOTTONS, SHOCKWAVE)

R Conmon Layoua] T Tables  Frames | Fosma] Tempiats] hrsrtes| M| Head S| Agpbeation]
2O EHH e S0890

El panel de insert contiene botones para la creacién e insercion de
diversos tipos de objetos, como tablas, capas e imagenes. Para
mostrar u ocultar el panel Objetos, elija Windows > insert. O presione
CTRL + F2

Para insertar un objeto:

Haga clic en el correspondiente botdén del panel insert o arrastre el
icono del botdén hasta la ventana de documento. Dependiendo del
objeto, aparecera el correspondiente cuadro de diadlogo de insercion
de objeto en el que se le pedird que seleccione o inserte el archivo u
objeto deseado.

Para omitir este cuadro de dialogo e insertar un objeto marcador de
posicion vacio:

Mantenga presionada la tecla Control (Windows) u Opcion
(Macintosh) mientras inserta el objeto. (Por ejemplo, para insertar un
marcador de posicion para una imagen sin especificar un archivo de
imagen, mantenga presionada la tecla Control u Opciény haga clic en
el botén Imagen.)

Nota: Esto no permite omitir todos los cuadros de didlogo. Algunos
objetos, como las barras de navegacién, las capas, los botones Flash,
los marcos, etc., no insertan marcadores de espacio.

El panel Insert contiene doce categorias de forma predeterminada:
Characters, Common, Forms, Frame, Head, layout y Especial.
También contiene botones que cambian de vista: Estandar vy
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Disposicion.

« La categoria Common contiene botones para la creacién e insercion
de los objetos mas utilizados, como Images, Tables y dra. layer.

La seccion layout permite elegir entre vista Estandar
(predeterminada) o de Disposicion. Si estd seleccionada la vista de
Disposicion, también podrd seleccionar las herramientas de
Disposicion: Dibujar celda de disposiciéon y Dibujar tabla de
disposicién. Para obtener mas informacion. Para cambiar de
categoria, utilice el mena emergente situado en la parte superior del
panel. Puede modificar cualquier objeto del panel o crear sus propios
objetos.

Algunas de las preferencias generales afectan al panel Objetos. Para
cambiar estas preferencias, elija Edit > Preference y seleccione
General.

«Cuando inserte objetos tales como imagenes, tablas, secuencias de
comandos y elementos head, aparecera un cuadro de didlogo en el que
se le solicitard informacion adicional. Puede suprimir estos cuadros
de didlogo desactivando la opcion Mostrar dialogo al insertar objetos
0 manteniendo presionada la tecla Control mientras crea el objeto.
Cuando se inserta un objeto con esta opcion desactivada, el objeto
recibe valores de atributo predeterminados. Después de insertar el
objeto, wutilice el inspector de propiedades para cambiar sus
propiedades.

«Las preferencias del panel Objetos permiten visualizar el contenido
del panel Objetos como texto solamente, iconos solamente o texto e
iconos.
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MACROMEDIA DREAMWEAVER
M X
CAPITULO 4

Al final del capitulo el alumno sera capaz de...

Utilizar la ficha layout
Utilizar la ficha text
Utilizar la ficha table
Utilizar lafichaframe
Utilizar la ficha form

Comprueba tu avance y marca con una g los objetivos alcanzados
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10.2 LAYOUT

La categoria loyout contiene botones que permiten crear objetos no
visibles en la ventana del navegador, como los puntos de fijacion con
nombre. Elija View > visual aids > Invisible elements para ver los
iconos que marcan la posicion de estos objetos. Haga clic en los
iconos de elementos invisibles de la ventana de documento para
seleccionar los objetos y cambiar sus propiedades.

10.3 TEXT, TABLE, FRAMES, FORMS, TEMPLATES,
CHARACTERS, MEDIA, HEADS, SCRIPT, APPLICATION

El panel Characters contiene caracteres especiales, como los
simbolos de copyright, de comillas curvas y de marca registrada.
Tenga en cuenta que estos simbolos no se muestran correctamente
en las versiones anteriores a la 3.0 de los navegadores (Netscape e
IE).

« La categoria Forms contiene botones que permiten crear formularios
e insertar elementos de formulario.

La categoria media contiene botones que permiten insertar
elementos especiales, como applets Java, plug-ins y objetos
Active X. Para obtener méas informacion.

La categoria Head contiene botones que permiten afadir diversos
elementos de la seccion head, como etiquetas meta, keywords y
base.

La categoria FRame contiene estructuras comunes de conjuntos de marcos.

En la categoria de common podemos encontrar la opcion de table, teble permite
crear una tabla para el manejo de datos de forma organizada. Para
dibujar una tabla solo pulse encima del iconoy se abrira un cuadro
de dialogo en el cual usted deberd especificar los tamafos de la
columna, anchos de la fila rellenos, etc.

la seccién head y la seccidon body. La seccion body es la parte
principal del documento, la parte visible que contiene texto,
imagenes, etc. La seccidén head es invisible, salvo el titulo del
documento, que aparece en las barras de titulo de las ventanas en
los navegadores y en Dreamweaver.
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La seccién head también contiene otra informacion importante,
incluido el tipo de documento, la codificacion de idioma, las funciones
y variables JavaScripty VBScript, las palabras clave y los indicadores
de contenido para motores de busqueda y las definiciones de estilo.
No es necesario suministrar todos estos elementos para cada pagina.
Por ejemplo, puede definir palabras clave e indicadores de contenido
para la pagina principal anicamente. Puede ver los elementos en la
seccion head utilizando el menu Ver, la vista de Codigo de la ventana
de documento o el inspector de codigo.

La pestafia de text en el panel de insert permite insertar etiquetas de
texto y permite dar formato al texto.

Nota la pestafia de texto en el panel de insert parecen similares a
algunos botones, en el panel de properties, las funciones son diversas
para cada tipo de boton.

Font Tag Editor: muestra un cuadro de dialogo donde permite dar
formato al texto seleccionado.

Bold, Italic: estas dos opciones son clasicos son simplemente de
negritay cursiva.

Application: Esta opcidén permite la conexidén a una base de datos.

Recordset: permite definir la ruta de una base de datos, y en donde se
almacenara la informacion.

Dinamic table: permite crear una tabla dinamica en una pagina, y
permite asociar a un recordset. Usted puede modificar el aspecto de
las tablas y la region repetida usando el panel de properties y el
behaviors del servidor de la region respectivamente.

Dinamic text: inserte un objeto dinamico de un texto en una pagina. El
objeto de tipo texto que usted inserte es un articulo de un recordset
predefinido, en la cual usted puede aplicar cualquiera de los formatos
de datos de Dreamweaver M X
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acam...

MACROMEDIA DREAMWEAVER
M X
CAPITULO S

Al final del capitulo el alumno sera capaz de...

Utilizar la ficha plantillas
Utilizar el panel de marcos
Conocer las propiedades de los marcos

Comprueba tu avance y marca con una g los objetivos alcanzados
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11 TEMPLATES
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Un template (plantillas) es un documento que sirve para crear
multiples paginas con el mismo disefio. Al crear una plantilla, podra
indicar qué elementos de la pagina deberdn permanecer constantes
(no editables o bloqueados) en los documentos basados en esa
plantilla, y que elementos podran modificarse.
Porejemplo, si usted publica una revista electrénica, es muy probable
que el diseflo de la cabecera y el disefio general no cambien de un
numero al siguiente, ni incluso de un articulo de la revista al que
ocupara el mismo lugar en el siguiente numero, pero el titulo y los
contenidos de cada articulo seran diferentes. El diseflador puede crear
el disefo de la pagina de un articulo de la revista con texto marcador
de posicion en los lugares en donde iran el titulo y el contenido (y con
esas regiones marcadas como editables); entonces, el disefiador
puede guardar ese disefio como plantilla. La persona que componga el
nuevo numero de la revista creara una nueva pagina basada en la
plantilla, y sustituird el texto marcador de posicion con el titulo y el
texto reales del nuevo articulo.
Puede crear una plantilla a partir de un documento HTML existente y
después modificarla para que se ajuste a sus necesidades, o bien
puede crear una plantilla comenzando de cero a partir de un
documento HTML en blanco.

Dreamweaver guarda las plantillas con la extension de archivo .dwt
en una carpeta Illamada Templates en la carpeta raiz local de su sitio.
Si no existe todavia la carpeta Templates, Dreamweaver la creara al
guardar una plantilla nueva.

Nota: No saque las plantillas de la carpeta Templates , ni guarde en
ella archivos que no sean plantillas. Tampoco debe sacar la carpeta
Templates de su carpeta raiz local. Hacerlo ocasiona errores en las
rutas de las plantillas.

La mayoria de las operaciones con plantillas solamente estan
disponibles cuando la vista de Disefio estqd activa. Si un comando
relacionado con plantillas esta atenuado cuando la vista de Codigo
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esta activa, hagaclic en la vista de Disefo.

Para guardar un documento existente como plantilla:

1 Elija File > Open y seleccione un documento.
2 Cuando se abra el documento, elija File > Save as Template.

Nota: Si el documento estd basado en una plantilla, primero debe
separarlo de la plantilla para poder guardar el propio documento
como plantilla.

3 En el cuadro de dialogo que aparece a continuacion, seleccione un
sitio en el menu emergente e introduzca un nombre para la plantilla
en el cuadro Save as.

4 Haga clic en OK.
El archivo de plantilla se guarda en la carpeta Templates con la
extension .dwt.

Para crear una plantilla nueva en blanco:

1 Elija File > New, aprece un cuadro de dialogo en el cual debera
seleccionar la opcion de Template, y seleccione uno. O bien también
lo puede hacer desde la ventana de preferencia

Edit>Preference. Y en el cuadro de dialogo seleccione la opcion que
dice New document, por default aparece HTML, en el cuadro de
DEFAULT DOCUMENT TYPE desplieguela y seleccione HTL
Template.
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12 USO DE FRAMES
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El uso mas comun de Frames (marcos) es la navegacion. Una pagina
Web puede utilizar un marco para albergar el mend de navegacion y
otro marco para el contenido de la pagina. Dado que el menu de
navegacion se encuentra en un marco, los visitantes pueden hacer clic
en un elemento del menu y el contenido aparecerd en el marco de
contenido sin que cambie el mend de navegacion. De este modo, el
visitante podra orientarse perfectamente en el sitio.
Hay dos formas de crear un conjunto de marcos en Dreamweaver:
puede diseflarlo usted mismo o seleccionarlo de una serie de
conjuntos de marcos predefinidos. Si elige un conjunto de marcos
predefinido se configuraran automéaticamente todos los conjuntos de
marcos y marcos necesarios para crear la disposicion. Esta es la
forma mas sencilla de insertar rapidamente un disefio de marcos en la
pagina. S6lo se pueden crear marcos en la vista Disefio de la ventana
de documento.

Los conjuntos de marcos predefinidos facilitan la seleccion del tipo de
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conjuntode marcos que desea crear.

Los iconos de conjuntos de marcos predefinidos de la categoria
Marcos del panel Objetos proporcionan una representacion visual de
cada conjunto de marcos al aplicarse a un documento seleccionado.

El conjunto de marcos seleccionado rodea al documento actual (el
documento en el que se encuentra el punto de insercion). El &rea azul
de un icono de conjunto de marcos predefinido representa la pagina o
el marco seleccionado actualmente en un documento, mientras que el
adrea blanca representa el nuevo o los nuevos marcos.

Para insertar un conjunto de marcos predefinido:

1 Sithe el punto de insercién en el documento.

2 Acontinuacion, lleve a cabo una de estas operaciones:

+En la categoria FRAMES del panel insert, seleccione un conjunto de
marcos predefinido. Para insertar el conjunto de marcos, puede hacer
clicenunicono o arrastrar un icono directamente al documento.

«Para seleccionar un conjunto de FRames predefinido, elija Insertar >
Marcos > lzquierda, Derecha, Arriba,

Abajo, lzquierda y arriba, Superior izquierda, lzquierda superior o
Dividir.

Antes de crear un conjunto de Frames o trabajar con Frames, haga
visibles los bordes de los marcos en la ventana de documento.

Para ver los bordes de los Frames de un documento, elija View >
Visual Aids > Frames Borders.

Cuando se muestran los bordes de los marcos, se afiade espacio
alrededor del borde del documento, lo que sirve de indicador visual de
las areas de marcos del documento.
Para crear un conjunto de marcos, lleve a cabo una de estas
operaciones:

«Elija Modify > Frameset > Slit frame left, Slit Frame right, Slit Frame
up Slit Frame down.
«Arrastre uno de los bordes del marco a la ventana de documento para
dividir el documento vertical u horizontalmente. Arrastre un borde del
marco por una de las esquinas para dividir el documento en cuatro
marcos nuevos.

«Presione la tecla Alt (Windows).

Paraeliminarun Frame

Arrastre el borde del marco fuera de la pagina o hasta el borde del
marco padre.
El panel Marcos proporciona una representacion visual de los marcos
del documento. Puede hacerclic en un marco o conjunto de marcos en
el panel Marcos para seleccionarlo en el documento y, seguidamente,
ver o editar las propiedades del elemento seleccionado en el inspector
de propiedades.
El panel Marcos también muestra la jerarquia de la estructura del
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conjunto de marcos de una manera que puede no percibirse en la
ventana de documento. En el panel Marcos, el conjunto de marcos
estad rodeado por un borde grueso tridimensional; los marcos estan
rodeados por una linea delgada gris; mientras que los distintos
marcos se identifican a través de sus nombres.

Para guardar un documento que estd dentro de un marco:

Haga clic en el marco para seleccionarlo y, a continuacién, elija File>
save Frame o File > Save Frame as.

Para guardar todos los archivos de un conjunto de marcos:
Elija File > Save all.

De este modo se guardaran todos los documentos abiertos, incluidos
los documentos individuales, los documentos de marcos y los
documentos de conjunto de marcos.

Nota: Utilice las lineas de seleccion de marcos de la ventana de
documento para identificar los documentos de conjunto de marcos o los
documentos de marcos al guardar los archivos.

12.1 PANEL DE FRAMES

- = Advanced Layout

topFrame

mainFrame

bottomFrame

Para mostrar el panel de Frames, lleve a cabo una de estas
operaciones:
«Elija Windows> other> Frames.

Para seleccionar un marco en el panel Marcos:

Hagaclic en el marco en el panel Marcos.
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Para seleccionar un conjunto de marcos en el panel Marcos:

Haga clic en el borde que rodea a los marcos en el panel Marcos.
Utilice el inspector de propiedades para asignar un nombre a un
marco y definir sus bordes y sus margenes. Para ver todas las
propiedades del marco, haga clic en la flecha de ampliacion que se
encuentra en el angulo inferior derecho del inspector de propiedades.
Es necesario asignar un nombre a cada uno de los marcos para que los
vinculos de la pagina funcionen correctamente.

Para especificar propiedades de marco:

Bskiam rame

= Properties E

['__ Fiaavee P Foe e IDEFECHANNRIRIF o= 2 31 Bordeis |n.u.ur .-l r)

! S Tl . Bogoll [rac <] [ Mofesie  BowdeCoke [ ] =
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1 Seleccione un marco llevando a cabo una de estas operaciones:
sHaga clic en un marco en el panel Marcos.

«Haga clic en un marco en la ventana de documento mientras presiona
la tecla Alt (Windows) o las teclas Opcion-Mayus (Macintosh).

2 Elija windows > properties para abrir dicha barra. Haga clic en la
flecha de ampliacion, situada en la esquina inferior derecha, para ver
todas las propiedades.

3 Para asignar un nombre al marco, escribalo en el campo frame
name.

Nota: Marco determina el nombre del marco actual que se utilizara
como destino de hipervinculos y referencias de secuencias de
comandos. El nombre de un marco tiene que estar formado por una
sola palabra. Se admite subrayado (), pero no guiones (-), puntos (.) ni
espacios. Los nombres de marcos deben comenzar con una letra (no
con un numero). No utilice palabras reservadas de JavaScript (como
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top o navigator) paralos nombres de los marcos.

4 Elijaunade las siguientes opciones de marco:

+Sc determina el documento de origen del marco. Introduzca un
nombre de archivo o hagaclic en el icono de la carpeta para examinar
y seleccionar el archivo. También puede abrirun archivo en un marco
colocando el punteroen el marcoy eligiendo File > Open frame.
«Scroll. Determina si apareceran barras de desplazamiento cuando no
haya suficiente espacio para mostrar todo el contenido del marco
actual. La configuracion predeterminada de la mayoria de los
navegadores es Automatico.

+«Mismo tamafio restringe el tamafio del marco actual e impide que los
usuarios puedan arrastrar los bordes del marco. Siempre podra
cambiar el tamafo de los marcos en la ventana de documento; sin
embargo, si esta seleccionada esta opcidn, los usuarios no podran
cambiarel tamafio de los marcos en sus navegadores.

.Bordes controla el borde del marco actual. Las opciones posibles son
yes, No y default. Si elige la opcién Bordes, se anulard la
configuracién de bordes definida para el conjunto de marcos. La
configuracién predeterminada de la mayoria de los navegadores es Si.
Un borde so6lo puede desactivarse cuando todos los marcos contiguos
estan definidos como No o0, cuando estidn definidos como
Predeterminado con el conjunto de marcos padre definido como No.
«Border color:- establece un color de borde para todos los bordes
contiguos al marco actual. Esta opcion de configuracion anula el color
de borde del conjunto de marcos.

5 Configure las siguientes opciones de méargenes (si las opciones de
margenes no estan visibles, haga clic en la flecha de ampliacidn
situada en la esquina inferior derecha).

Margin width Establece en pixeles el ancho de los margenes izquierdo
y derecho (es decir, del espacio que hay entre el borde del marcoy su
contenido).

Margin Height Establece en pixeles el alto de los margenes superior e
inferior (es decir, del espacio que hay entre el borde del marco y su
contenido).

Controlar el contenido del marco con vinculos

Para utilizar vinculos en marcos, debera establecer un destino para el
vinculo. EIl destino es el marco en el que se abrird el contenido
vinculado. Por ejemplo, si el mena de navegacidn se encuentra en el
marco izquierdo y desea que el material vinculado aparezca el marco
de contenido principal, deberd utilizar destinos para todos los
vinculos del menud de navegacion. El destino tendrd el nombre del
marco de contenido principal, por ejemplo, marco_principal. Cuando
el usuario haga clic en un vinculo de navegacion, el contenido se
abrirdenel marco principal.

Si desea seleccionar un marco para abrir un archivo en él, debera
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utilizar el menu emergente Destino en el inspector de propiedades.
Puede establecer la apertura de un archivo en un nuevo marco,
sustituir informacion en el marco del vinculo o sustituir informacion
en otro marco. También puede hacer que el contenido vinculado
sobrescriba el marco actual (para ello, no seleccione un destino) o que
aparezcaen unaventana de navegador totalmente nueva.
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Cuestionario b

1.- Definicion de plantilla

2.- Procedimiento para un panel de plantillas

3.-definicion de marco (frame)

4.-Procedimiento para verel panel de marcos (frames)
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ACAM...ooe

MACROMEDIA DREAMWEAVER
M X
CAPITULO®G

Al final del capitulo el alumno sera capaz de...

Utilizar el panel de comportamiento
Insertar sonido

Insertar video

Insertar un mail link

Comprueba tu avance y marca con una g4 los objetivos alcanzados

Instituto de Computacion Activa de México S. C. 48



MACROMEDIA DREAMWEAVER MX

13 COMPORTAMIENTO PANEL BEHAVIORS

Los comportamientos permiten a los visitantes interactuar con la
pagina Web para modificarla de diversas maneras o provocar la
realizaciéon de determinadas tareas. Un comportamiento es una
combinacion de un evento con una accion que desencadena ese
evento. En el panel Comportamientos, un comportamiento se afiade a
una pagina especificando una accion y especificando luego el evento
gue desencadena esa accion.

Los eventos son mensajes generados por los navegadores que indican
que un visitante de la pagina ha hecho algo. Por ejemplo, cuando un
visitante mueve el puntero sobre un vinculo, el navegador genera un
evento onMouseOver para ese vinculo; y luego comprueba si hay
codigo JavaScript al que deba llamar cuando se genera ese evento
para ese vinculo. Los diferentes elementos de la pagina tienen
definidos diferentes eventos; por ejemplo, en la mayoria de los
navegadores onMouseOver y onClick son eventos asociados con
vinculos, en donde onLoad es un evento asociado con imagenes y con
la seccion body del documento.

Las acciones constan de cddigo JavaScript ya definido que realiza una
tarea especifica, como abrir la ventana de un navegador, mostrar u
ocultar una capa, reproducir un sonido o detener una pelicula
Shockwave. Las acciones incorporadas en Dreamweaver han sido
cuidadosamente desarrolladas por los ingenieros de Dreamweaver
para proporcionar la maxima compatibilidad con los distintos
navegadores

13.1 SONIDO (MP3, WAV, MIDI)

Hay varios tipos de archivos y formatos de sonido, y varias formas de
afiadir sonido a una pagina Web. Los factores que hay que tener en
cuenta antes de optar por un formato y un método para afiadir sonido
son: su finalidad, el tipo de usuarios a los que estd destinado, el
tamafo de archivo, la calidad de sonido y las diferencias en los
navegadores.

Formatos de archivo de audio
La lista siguiente describe los formatos de archivo de audio mas

comun, junto con algunas de sus ventajas y desventajas en relacidon
con el disefio Web.

El formato .midi o .mid (Interfaz Digital para Instrumentos Musicales)
es un formato de mdasica instrumental. Muchos navegadores
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reconocen los archivos MIDI y, por tanto, no requieren un plug-in. S
bien su calidad de sonido es muy alta, puede variar segun la tarjeta de
sonido del usuario. Un pequefio archivo MIDI puede proporcionar un
clip de sonido de larga duracion. Los archivos MIDI no se pueden
grabar y deben sintetizarse en un ordenador con hardware y software
especiales.

Los archivos de formato .wav (Extensién de Formas de Onda) ofrecen
una buena calidad de sonido, son compatibles con muchos
navegadores y no requieren un plug-in. Puede grabar sus propios
archivos WAV desde un CD, una cinta, el micréfono, etc. Sin embargo,
el gran tamafio de archivo limita considerablemente la duracién de
los clips de sonido que se pueden utilizar en las paginas Web.

El formato .aif (Formato de Archivo de Intercambio de Audio o AIFF),
al igual que el formato WAV, ofrece buena calidad de sonido, se puede
reproduciren la mayoria de los navegadores y no requiere un plug-in.
También se pueden grabar archivos AIFF desde un CD, una cinta, el
microfono, etc. Sin embargo, el gran tamafio de archivo limita
considerablemente la duracion de los clips de sonido que se pueden
utilizaren las paginas Web.

El formato .mp3 (Audio del Grupo de Expertos en Imagenes en
Movimiento o MPEG-Audio Nivel-3) es un formato comprimido que
reduce considerablemente el tamafo de los archivos de sonido. La
calidad de sonido es excelente: si se grabay comprime correctamente
un archivo MP3, su calidad es equiparable a la de un CD. La nueva
tecnologia permite reproducir el archivo en flujo (streaming) de modo
que el visitante no tenga que esperar a que se descargue todo el
archivo para escucharlo. Sin embargo, el tamafo de archivo es mayor
gue el de Real Audio, por lo que una cancién entera puede tardar
bastante en descargarse a través de una conexion teleféonica normal.
Para reproducir archivos MP3, los visitantes deberdn descargar e
instalar una aplicacion auxiliar o un plug-in como QuickTime,
Windows Media Player o RealPlayer.

El formato .ra, .ram, .rpm o Real Audio tiene un alto grado de
compresidon con tamafios de archivo mas pequefios que MP3. Permite
descargar archivos de canciones completas en un periodo de tiempo
razonable. Dado que los archivos se pueden reproducir en flujo desde
un servidor Web normal, los visitantes pueden comenzar a escuchar el
sonido antes de que el archivo se haya descargado por completo. La
calidad de sonido es mas pobre que la de los archivos MP3, aunque los
nuevos reproductores y codificadores la mejoran considerablemente.
Los visitantes deberan descargar e instalar la aplicacion auxiliar o
plug-in RealPlayer para reproducir estos archivos.

El establecimiento de vinculos con archivos de audio es una forma
sencillay efectiva de afiadir sonido a una pagina Web. Este método de
incorporar archivos de sonido permite a los visitantes optar por
escuchar el archivo, y hace que el archivo esté disponible para un
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mayor numero de usuarios. Algunos navegadores no admiten los
archivos de sonido incrustados.
Para establecer wun vinculo con un archivo de audio:
1 Seleccione el texto o la imagen que desea usar como vinculo con el
archivo de audio.

2 En el panel de properties, haga clic en el icono de carpeta para
acceder al archivo de audio o escriba la ruta y el nombre del archivo
en el campo Vinculo.
Al incrustar audio se incorpora el reproductor de sonido directamente
en la pagina, pero el sonido s6lo se reproduce si los visitantes del sitio
disponen del plug-in adecuado para el archivo de sonido elegido.
Incruste archivos si desea utilizar el sonido como musica de fondo o si
desea obtener un mayor control sobre la presentacion de sonido. Por
ejemplo, puede establecer el volumen, la apariencia del reproductor
en la paginay los puntos inicial y final del archivo de sonido.

Para incrustar un archivo de audio:

1 En la vista de Disefio, sitie el punto de insercion en el lugar donde
deseaincrustarel archivo.

2 Haga clic en el botdn Plug-in del panel Objetos o elija Insert > Media
> Plugin.

Para obtener méas informacion sobre el objeto Plug-in.

3 Enelinspector de propiedades, haga clic en el icono de carpeta para
acceder al archivo de audio o escriba la ruta y el nombre del archivo
enel campo Vinculo.

4 Especifique el ancho y el alto introduciendo los valores en los
campos correspondientes o cambiando el tamafio del marcador de
posicion del plug-in en la ventana de documento.

Estos valores determinan con qué tamafio se muestran los controles de
audio en el navegador. Por ejemplo, pruebe con un ancho de 144 pixelesy
un alto de 60 para ver como aparece el reproductor de audio en Navigator
y en Internet Explorer.

13.2 VIDEO

Videos Shockwave, el estandar de Macromedia para multimedia
interactivo en la Web, es un formato comprimido que permite la
descarga rapida de los archivos de medios creados en Macromedia
Directory su reproduccién en los navegadores de uso mas frecuente.

El software que reproduce las peliculas Shockwave estd disponible
como plug-in para Netscape Navigator y en formato de control
ActiveX. Cuando se inserta una pelicula Shockwave, Dreamweaver
usa tanto la etiqueta object (para el control ActiveX) como la etiqueta
embed (para el plug-in) para conseguir los mejores resultados en
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todos los navegadores. Al realizar cambios relativos a la pelicula en el
inspector de propiedades, Dreamweaver adapta los datos introducidos
a los parametros correspondientes para las etiquetas objecty embed.
Para insertar una pelicula Shockwave:

1 En la vista de Disefio de la ventana de documento, sitde el punto de
insercidon en el lugar donde desea insertar una pelicula Shockwave.
2 Haga clic en el boton Shockwave del panel properties o elija Insert >
Media > Shockwave o arrastre el boton Shockwave sobre el
documento.

3 En el cuadro de dialogo que aparece, seleccione un archivo de
pelicula.

4 En el panel de properties, introduzca el ancho y el alto de la pelicula
enlos cuadros W y H. El panel de properties muestra inicialmente las
propiedades utilizadas con mayor frecuencia. Haga clic en la flecha
de ampliacidn, situada en la esquina inferior derecha, para ver todas
las propiedades.
Nombre especifica un nombre para identificar una pelicula en las
secuencias de comandos. Introduzca un nombre en el campo sin titulo
que aparece a laizquierda del inspector de propiedades.

Wy Hespecifican el ancho y el alto de la pelicula en pixeles. También
se pueden emplear las siguientes unidades: pc (picas), pt (puntos), in
(pulgadas), mm (milimetros), cm (centimetros) o % (porcentaje del
ancho o el alto del objeto padre). Las abreviaturas deben seguir al
valorsin espacio de separacion: porejemplo, 3mm.

File especifica la ruta del archivo de la pelicula Shockwave. Haga clic
en el icono de carpeta para localizar un archivo o escriba la ruta
correspondiente.

Align determina como se alineara la pelicula en la pagina. Para
obtener una descripciéon de cada opcion.

bg especifica un color de fondo para la zona de la pelicula. Este color
también aparecera cuando la pelicula no se esté reproduciendo
(mientras se cargay después de haberse reproducido).

Reproducir permite previsualizar la pelicula en la vista de Disefio de
la ventana de documento. Haga clic en el botén Detener para
interrumpir la pelicula y volver al marcador de posicion de
Shockwave.

Parametros abre un cuadro de didlogo para introducir parametros
adicionales que se transferiran a la pelicula Shockwave. La pelicula
Shockwave debera estar disefiada para recibir estos pardmetros.

ID define el parametro opcional ID ActiveX. El uso mas frecuente de
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este parametro es la transmision de informacidén entre controles
ActiveX.

W space y H space especifican el numero de pixeles de espacio en
blanco que habra por encima, por debajo y a ambos lados de la
pelicula.

14 CORREO ELECTRONICO

Correo electronico Cuando el usuario hace clic en un vinculo de
correo electronico se abre una ventana de mensaje en blanco
(utilizando el programa de correo asociado al navegador del usuario).
En la ventana de mensaje de correo electrénico, el campo Para se
rellena automéaticamente con la direccion especificada en el vinculo.
Para crear un vinculo de correo electronico utilizando el comando
Insertar vinculo de correo electrénico:

1 En la vista de Disefio de la ventana de documento, sitie el punto de
insercidén donde desea que aparezca el vinculo de correo electrénico o
seleccione el texto que desea mostrar como vinculo de correo
electrénico. Acontinuacién, lleve a cabo una de estas operaciones:

«Elija Insert >email link
«En la categoria Common del panel insert, el boton de email link.

2 En el campo Text del cuadro de dialogo Insertar vinculo de correo
electronico, escriba o edite el texto que desea mostrar en el
documento como vinculo de correo electronico.

3 En el campo email, escriba la direccién a la que se deberé enviar el
correo electrénico.

4 Haga clic en OK.
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Cuestionario 6

1.- Definicion de comportamiento

2.- Lenguaje en que se generan los comportamientos

3.- Formatos de sonidos que soporta Dreamweaver

4.- Formatos de video que soporta Dreamweaver

5.- Instruccion que genera un Hipervinculo de correo
electronico
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MACROMEDIA DREAMWEAVER

M X
CAPITULO 7

Al final del capitulo el alumno sera capaz de...

Conocer que es una base de datos

Crear una base de datos

Conocer que es una tabla

Conocer que es un campo

Conocertipo de conexidn

Conectar una base de datos

Visualizar registros

Filtrar registros

Utilizar los recordsetinsertion

Utilizar recordset update form

Crear una pagina de detalle maestro

Crear un repeatregion

Crear paginas de login confirm

Crear paginas de restring page

Crear redirection page

Comprueba tu avance y marca con una g& los objetivos alcanzados
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Boton:

\uevo

1 BASE DE DATOS (APLICATION)

Una base de datos es un conjunto de informacion relacionada con un
asunto o con una finalidad. En Access, una base de datos es un archivo
gue puede contener tablas donde se encuentra toda la informacién sobre
un tema especifico, consultas, formularios, informes entre otros. Tal como
una coleccién de mausica, el control de alumnos en un colegio o un
directorio telefénico.

2 CREAR UNA BASE DE DATOS EN ACCESS

Microsoft Access proporciona dos métodos para crear una base de
datos de Access, Utilizando el Asistente para Base de datos, o bien,
puede crear una base de datos en blanco y, posteriormente, agregar
las tablas, formularios, informes y demaés objetos que desee; éste es el
método mas flexible, pero requiere definir por separado cada
elemento de la base de datos. Cualquiera que sea el método elegido,
puede modificar y ampliar la base de datos en cualquier momento
posteriorasu creacion.

Para crear una base de datos en blanco existen los siguientes
métodos:

1. Menu Archivo/ Nuevo...

2. Hacer clic sobre la opcidén Base de datos en blanco del panel de
tareas que aparece a la derecha de la pantalla.
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3 CONCEPTO DE UNA BASE DE DATOS

Campos (columnas)

“omber | LastNam | Frstams | Poston | Gosie |

Registros
(filas)

El componente basico de la base de datos es el registro. Un registro es
un conjunto de datos relacionados que se tratan como una sola
entidad. Por ejemplo, un tarjeta de futbol podria considerarse un
registro: contiene el nombre, la fotografia, el equipo y las estadisticas
de un jugador. Empleando la terminologia propia de las bases de
datos, cada uno de esos elementos de informacion recibiria el nombre
de campo: cada "registro™ de tarjeta de fatbol tiene un campo nombre,
un campo fotografia, un campo equipo y varios campos de
estadisticas.

Al juego de registros que comparten los mismos campos se le llama
tabla, porque este tipo de informacion puede presentarse facilmente
en formato de tabla: cada columna representa un campo y cada fila
representa un registro. De hecho, la palabra columna es sinénimo de
la palabra campo, y la palabra fila es sin6nimo de la palabra registro.

Una base de datos puede contener mas de una tabla, cada una de las
cuales tiene un nombre exclusivo. Estas tablas pueden estar
relacionadas o serindependientes entre si.

Un subconjunto de datos extraidos de una o mas tablas recibe el
nombre de juego de registros. Un juego de registros también es una
tabla porque es una coleccion de registros que comparte las mismas
columnas. Por ejemplo, una alineacidon de un equipo de futbol en la
que se relacionan los nombres y las posiciones de los jugadores en el
campo seria un juego de registros: consta de un subconjunto de toda la
informacion posible sobre los jugadores, incluidos los goles las
asistencias, las faltas, etc.
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4 TABLA
[ Norber| LootNaro | Firitame | Pestion | Geals ]
N
I N
I N
Tabla de base de datos \

Tabla de jusgo de registros

Para crear un juego de registros, se realiza una consulta de base de
datos. Una consulta consta de criterios de busqueda. Por ejemplo, la
consulta puede especificar que so6lo se incluyan algunas de las
columnas en el juego de registros, o que so6lo se incluyan
determinados registros.

Las tablas se componen de filas y columnas de celdas que se pueden
rellenar con texto y graficos. Las tablas se utilizan a menudo para
organizar y presentar informacion. Resulta util saber como se
denominan las diversas partes de una tabla. Columna, Fila, Celda.
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S CAMPOS

Los campos o columnas de una Tabla identifican el tipo de dato que se
almacenara en dicha posicidn, asi como el nombre de este.

REGISTRO

Conforma toda la informacion correspondiente a las filas de esa tabla.

6 CONFIGURACION DE SITIO

A continuacién se describe la configuracion de sistema mas sencilla
para usuarios de Windows.
Para configurarel sistema:

1 Si es usted usuario de Windows 95, 98 o NT Workstation, instale
Microsoft Personal Web Server (PWS).

2 Si es usted usuario de Windows NT Server o Windows 2000,
asegurese de que Internet Information Server (I11S) esta instalado y en
ejecucidénensusistema.

I1S es la version completa de PWS. Ya debe estar instalado en su
sistema. Si no lo esta, instalelo o solicite al administrador del sistema
que se lo instale.

3 Si desea realizar el curso practico para ColdFusion, instale
ColdFusion Serveren el sistema.

Para obtenerinstrucciones.

4 Si desea realizar el curso practico para JSP, instale los siguientes
componentes en el sistema.

«Java 2 SDK, Standard Edition, para Windows

El controlador JDBC-ODBC Bridge de Sun se instala automéaticamente
al instalar SDK.

«Un servidor de aplicaciones que tenga implementada la
especificacion JavaServer Pages 1.0 de Sun.

5 Cree una subcarpeta en la carpeta c:\Inetpub\wwwroot y llamela
MyTutorialSite.

Esta es la estructura de carpetas correcta:

c:\Inetpub\wwwroot\ MyTutorialSite
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7 SITIO LOCAL

Para configurar sitio local Dreamweaver M X:
1.-elijalaopcion de site> new site

2.-en el cuadro de dialogo especifique el nombre del sitio
name: nombre del sitio

local root folder: ruta de acceso a los archivo, donde se guardaran
todos los archivo

3.-oprimaeliconocon forma de folder para especificar la ruta una vez
seleccionada la carpeta presione guardar.

Nos regresara al sitio donde empezamos solo hay que presionar OK.

8 SITIO REMOTO

Para configurar sitio remoto Dreamweaver MX:

1 Inicie Dreamweaver y elija Site > New Site. Aparecera el cuadro de
dialogo Definir sitios.

2 Seleccione el sitio del curso practico ASP, ColdFusion o JSP
predefinido y haga clic en Editar.MX definié los sitios del curso
practico durante la instalacién.

3 Haga clic en Datos remotos y complete el cuadro de dialogo de la
siguiente  forma: Acceso: Local/Network Carpeta remota:
c:\Inetpub\wwwroot\ MyTutorialSite

4 Si desea realizar el curso practico de ASP, haga clic en Servidor de
aplicaciones y complete el cuadro de dialogo de la siguiente forma:
Modelo de servidor: ASP 2.0. Lenguaje de secuencia de comandos:
VBScript o JavaScript Extension de pagina: .asp Acceso:
Local/ Network Carpeta remota: c:\Inetpub\wwwroot\ MyTutorialSite
Prefijo de URL: http://localhost/ MyTutorialSite. La base de datos del
curso practico es un archivo de Microsoft Access 97. No es necesario
Microsoft Access para realizarel curso practico, aunque si necesita un
controlador capaz de leer archivos de Microsoft Access 97. El
controlador permite a la aplicaciéon Web leer el contenido del archivo

Instituto de Computacion Activa de México S. C. 60



MACROMEDIA DREAMWEAVER MX

de base de datos. (Para ampliar conocimientos sobre controladores de
bases de datos.

S es usted ingeniero de desarrollo de ASP o ColdFusion, debera tener
instalado un controlador ODBC capaz de leer archivos de Access 97 en
el servidor ASP o ColdFusion. Si su servidor Web se ejecuta en un
sistema Windows remoto o local, es probable que el controlador
necesario ya esté instalado. Para averiguar si lo estd, elija Inicio >
Configuracion > Panel de control en Windows y busque el icono de
ODBC Data Sources. (En funcion del sistema, el icono también puede
denominarse ODBC o 32bit ODBC.) Si no encuentra el icono,
descargue e instale Microsoft Data Access Components (MDAC) 2.5,
gue instalara el controlador de Access. Si el icono ODBC Data Sources
esta presente en el Panel de control, haga doble clic en él. Aparecera
el cuadro de dialogo ODBC Data Sources Administrator. Haga clic en
la ficha Drivers para obtener una lista de controladores instalados en
el sistema. Busque el controlador Microsoft Access Driver, version 3.5
0 posterior. Si el controlador Microsoft Access Driver (*.mdb) no
aparece en la lista, descargue e instale MDAC, que instalara el
correspondiente controlador de Access. Antes de comenzar a crear el
directorio de empleados de Compass, debera crear una conexidn con
el archivo de base de datos del curso practico, compasstravel.mdb.

Si ha instalado Dreamweaver en un sistema Windows, durante la
instalacion se establecio en el sistema un DSN para la base de datos
del curso préactico. Debera utilizar dicho DSN si ejecuta también el
servidor Web en el mismo sistema (es decir, si utiliza Personal Web
Server en Windows o si instalé Dreamweaver en Windows NT Server o
Windows 2000).

Si el servidor Web se ejecuta en un sistema Windows remoto, puede
definir un nombre de fuente de datos (DSN) en el servidor remoto y
luego utilizar dicho DSN en Dreamweaver para crear una conexion de
base de datos sencilla. Un DSN es una especie de acceso directo a una
base de datos. Para obtener instrucciones sobre como definir uno.
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9 TIPOS DE CONEXION DE BD.

Ed
R
Dcﬁ'l!l mg|

Mame: |Recordsst |
Connedion: |l:-:|rr-:mrp-::ﬁtraw:l J
Table: [COMMENTS | Test
Columns: (7 Al Salackad: Advanced. ..
=l
Filter: [H-me :J | J
Sort: [Here | = K

Si no se ha definido ningdn DSN en el sistema que ejecuta el servidor
Web, debera utilizar una cadena de conexion para crear la conexion.

Para crear una conexion de base de datos en el caso de que se haya
definidoun DSN en el servidor Web:

1 en el panel de insert haga clic en la pestafia de application y de un
clic en el boton que dice recordset aparecera el cuadro de didlogo de
Conexiones.

2 Haga clic en define... Nombre de fuente de datos (DSN) del menu
emergente.

Aparecerda el cuadro de didalogo Nombre de fuente de datos (DSN). En
caso de no parecer la ventana emergente haga clic en new.

3 Enelcuadro Nombre de conexién, introduzca connCompass.

Una practica habitual consiste en afiadir el prefijo conn a los nombres
de conexiones para distinguirlos de los nombres de objetos en el
codigo.
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4 S el servidor de aplicaciones se ejecuta en el equipo local,
seleccione CompassTravel de lalistade DSN, y haga clic en ok.

5 S el servidor de aplicaciones se ejecuta en un equipo remoto,
introduzca CompassTravel en el cuadro Nombre de fuente de datos
(DSN).

6 Haga clic en Done para finalizar la definicion de la conexion.

La nueva conexién, con Compass, aparecerd en el cuadro de didlogo
Conexiones.

7 Haga clic en ok paracerrarel cuadro de didlogo Conexiones.

10 CONEXION A LA BASE DE DATOS

Para crear una conexion de base de datos para el curso practico ASP:

1 En Dreamweaver, elija Conexiones del panel insert en la pestafa
application.
Aparecera el cuadro de didlogo Conexiones.

2 Haga clic en el boton Define... y seleccione Nombre de fuente de
datos (DSN) del menu emergente.

Aparecerd el cuadro de didalogo Nombre de fuente de datos (DSN). En
caso de no aparecer el cuadro de las opciones de clic en boton que
New, y del menua que aparece de clic en DARA SOURCE NAME (DSN)

3 Introduzca el siguiente nombre para la nueva conexion:
connCompass.

Una practica habitual consiste en afiadir el prefijo conn a los nombres
de conexiones para distinguirlos de los nombres de objetos en el
codigo.

4 Seleccione CompassTravel de la lista de DSN. Si aparece escribala
tal cual.

Dreamweavercred el DSN CompassTravel durante la instalacidn.

5 Haga clic en Test.

Dreamweaver intentard conectar con la base de datos. Si falla la
conexion, compruebe de nuevo el DSN. Si la conexidon continla
fallando, compruebe el prefijo de URL del servidor de aplicaciones.
Presione OK

6 Haga clic en Done.
La nueva conexion debe apareceren el cuadro de didlogo Conexiones.

7 Haga clic en OK para cerrar el cuadro de dialogo Conexiones. Un
sitio local indica a Dreamweaver el lugaren el que estan almacenados
todos los documentos y archivos de un sitio Web concreto en el disco
local. Debe definir un sitio local para desarrollar una aplicacién Web
utilizando Dreamweaver.
Puede utilizar Dreamweaver para desplegar la aplicacion en un
servidor Web mediante la definicion de un sitio remoto. Un sitio
remoto indica a Dreamweaver el lugar en el que estdn almacenados
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todos los documentosy archivos del sitio Web en el servidor Web.

Para definir un sitio remoto, realice las siguientes tareas:
«Defina una carpeta publicada en el servidor Web.

sDefina la carpeta del sitio remoto en Dreamweaver.

11 VISUALIZAR REGISTROS

Un juego de registros es un subconjunto de datos extraidos de una o
varias tablas de una base de datos. Actia a modo de fuente de datos
para las paginas dinamicas. Debera definir un juego de registros que
contenga soélo los registros devueltos por la busqueda. En el caso de un
conjunto simple de paginas de busqueda/resultados, puede crear este
tipo de juego de registros definiendo un filtro.

Debera comenzar definiendo el contorno general del juego de
registros.

1 En el mena Site> Site file, haga doble clic en el archivo connection
situado bajo Carpeta local.

Se abrird en Dreamweaver la pagina de resultados simple para el
directorio de empleados de Compass.

2 En el panel Vinculaciones de datos, haga clic en el botén de signo
mas (+) y seleccione Recordset (Query (consulta) del menu
emergente. Aparecerd el cuadro de didlogo Juego de registros simple.

3 En el cuadro Nombre, introduzca Results. Este es el nombre del
juego de registros. No lo confunda con el nombre de archivo de la
pagina. En este caso, se trata del mismo nombre.

4 Seleccione la conexién connCompass del mend emergente
Conexion.
Si no aparece en el menua, haga clic en el boton Define... para crearla.

5Enel ment emergente Tabla, seleccione EMPLOYEES.

6 En el &rea Columnas, haga clic en la opcion Seleccionado para elegir
las columnas seleccionadas de la table EMPLOYEES.
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7 Presione Control (Windows) en las siguientes columnas de la lista
para incluirlas en el juego de registros: EM PLOYEEID, FIRSTNAME,
LASTNAME, DEPARTMENT y EXTENSION. La pagina de resultados
muestra informacion de cuatro de estas columnas. Debe incluir la
columna EMPLOYEEID porque contiene informacién que identifica a
cada registro individual (informacién que sera atil méas adelante
cuando cree una pagina de detalle).

8 Haga clic en Prueba para comprobar el juego de registros.
Aparecera un juego de registros con datos extraidos de la tabla de la
base de datos. Haga clic en Aceptar para cerrarlo.

De forma predeterminada, el juego de registros contiene todos los
registros de la tabla de la base de datos. Deje abierto por ahora el
cuadro de didlogo Juego de registros. Lo utilizara a continuacion para
crear un filtro que elimine todos los registros que no cumplan los
criterios de basqueda

9 Haga clic en Ok.

Dreamweaver afiade el juego de registros a la lista de fuentes de datos
disponibles en el panel Vinculaciones de datos. Para ver los campos
definidos para el juego de registros, amplie la rama del juego de registros.

10 Arrastre cada uno de los campos hacia el area de la pagina

11 Guarde € trabgjo (File > Save).

12 FILTRAR REGISTROS

para filtrar registros solo arrastre los campos a la hojay listo

13 RECORDSET NAVIGATION BAR

La pagina de resultados debe permitir a los usuarios desplazarse
hacia delante y hacia atras por la lista de resultados si la busqueda
devuelve mas de cinco registros. La pagina del curso préactico incluye
las imé&genes "Previous' (anterior) y "Next" (siguiente) para este fin.
Su trabajo consiste en activar estas imagenes de forma que, cuando el
usuario haga clic en ellas, la pagina muestre mas resultados (en el
caso de que existan).

1 Seleccione laimagen "Previous' en la pagina.

2 En el panel server behaviors, haga clic en el botdon de signo més (+) y
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seleccione Recordset paging > move to previous recordset.
Aparecera el cuadro de didalogo Move to previous recordset.

3 En el ment emergente Juego de registros, asegurese de que esta
seleccionado el juego de registros de resultados y haga clic en OK.

4 Repita el procedimiento para la imagen "Next", con la diferencia de
gue, en esta ocasion, deberd seleccionar Move to next recordset

5 Guarde el trabajo (File > Save).

Si comete algun error, abra el panel Comportamientos del servidory
haga clic en el botdén de signo menos (-) para borrarlo.

Si es probable que las busquedas generen gran cantidad de
resultados, puede afadir un contador de registros a la pagina para
ayudar a los usuarios a conocer el lugar en el que se encuentran
dentro del juego de registros.

14 RECORDSET INSERTION FORMS

La categoria de Forms del panel Insert contiene botones que permiten
crear formularios e insertar elementos de formulario.

Los formularios son simplemente contenedores de elementos de
formulario; los limites del formulario no son visibles en la ventana de
documento a menos que se seleccione View > visual aids> invisible
elements.

Coloque el punto de insercion dentro de los limites del formulario
antes de insertar el elemento de formulario; los elementos de
formulario situados fuera de las etiquetas form no aparecen en todos
los navegadores. Si intenta insertar un elemento fuera del formulario,
un cuadro de didlogo le preguntara si desea afiadir una etiqueta de
formulario alrededor de dicho elemento. Haga clic en Si para crear un
formulario que contenga el elemento o en No para insertar el elemento
sin formulario.

Form coloca un formulario en el punto de insercion.
Tex Field coloca un campo de texto en el punto de insercion.
Establezca el nombre, el tamafio y el valor inicial en el inspector de
ropiedades.

]

Button coloca en el punto de insercion un botén con Submitcomo valor
predeterminado de las etiquetas name y vaule. Coloque el punto de
insercion dentro de los limites del formulario antes de insertar el
boton; los botones situados fuera del formulario no aparecen en todos
los navegadores. Utilice el inspector de propiedades para establecer el
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nombre, la etiqueta y la accion.
]

Check box coloca una casilla de verificacion en el punto de insercion.
Establezca el nombre, el valor de activacion y el estado inicial en el
inspector de propiedades.

B

Radio button coloca un botdn de opcidon en el punto de insercion.
Establezca el nombre, el valor de activacion y el estado inicial en el
inspector de propiedades.

Listmenu coloca una lista o menu emergente en el punto de insercién.
Establezca el nombre, el tipo y los valores iniciales en el inspector de
ropiedades.
El
File field coloca un campo de archivo en el punto de insercion.
Establezca el nombre, el tamafio y el valor inicial en el inspector de
propiedades. Consulte Permitir a los visitantes que carguen un
archivo en su servidor.

]

Image field coloca un campo de imagen en el punto de insercidn.
Establezca el nombre, el tamafo, el texto alternativo y el archivo de
origen en el inspector de propiedades.
Hidden field coloca un campo oculto en el punto de insercién.
Establezca el nombre y el valoren el inspector de propiedades.

i)

Jump menu coloca un menud emergente de URL en el punto de
inserciéon. Al elegir un valor de este menu, el usuario se traslada al
URL. Establezca los valores de la lista en el cuadro de dialogo que
aparece.

A

15 DELETE RECORDSET

El siguiente paso consiste en afiadir el comportamiento de servidor
Borrar registro para actualizar la tabla de la base de datos cuando el
usuario hagaclic en el botén Submit.

Para afladir un comportamiento de servidor para borrar la tabla de la
base de datos.
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1 En el panel applcation,haga clic en la pestafia de server behaviors,
haga clic en el botdn de signo mas (+) y seleccione Actualizar registro
enel ment emergente. Seleccione delete record. Aparecera el cuadro
de dialogo Borrar registro.

2 Utilice los menus contextuales connection y delete from table para
especificar la tabla de la base de datos que contiene los registros que
se van a borrar.

3 En el ment emergente select record from, especifique el juego de
registros que contiene el registro que se va a borrar.

4 En el menu emergente unique key column, seleccione una columna
de clave (generalmente, la columna ID del registro) para identificar el
registro de la tabla de la base de datos.

Si el valor es un numero, seleccione la opcion Numérico.
Generalmente, las columnas de clave so6lo admiten valores
numericos, pero también pueden aceptar valores de texto.

5 En el cuadro after deleting go to, introduzca la pagina que se debe
abrir después de borrarel registro de la tabla.

6 En el mend emergente deleting by submitting, especifique el
formulario HTML que contiene el boton Submit que envia el comando
de borrado al servidor.

Dreamweaver elegira automéaticamente el primer formulario de la
pagina.

7 Hagacclic en Ok.

16 RECORDSET UPDATE FORM
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Para afladir un comportamiento de servidor para actualizar la tabla de
la base de datos.

1 En el panel Server behaviors , haga clic en el botdn de signo mas (+)
y seleccione update record en el menu emergente.
Aparecera el cuadro de dialogo Actualizar registro.

2 Utilice los menuds contextuales Connecton y Table to update para
especificar la tabla de la base de datos que contiene los registros que
se van a actualizar.

3 En el menu emergente selecc record from, especifique el juego de
registros que contiene el registro que aparece en el formulario HTML.

4 En el menu emergente unique key column, seleccione una columna
de clave (generalmente, la columna ID del registro) para identificar el
registro de la tabla de la base de datos.

Seleccione la opcién Numeérico si el valor es un numero.
Generalmente, las columnas de clave so6lo admiten valores
numericos, pero también pueden aceptar valores de texto.

5 En el cuadro after updating to go, introduzca la pagina que se debe
abrirdespués de actualizar el registro de la tabla.

6 En el mend emergente get value from, elija el formulario HTML
utilizado para editar los datos del registro.
UltraDev elegird automaticamente el primer formulario de la pagina.

7 Especifique el campo de la tabla de la base de datos que actualizara
cada objeto del formulario. Para ello, seleccione un objeto de
formulario en la lista Elementos de formulario y elija una columna de
la tabla en el menu emergente Columna y el tipo de datos
correspondiente en el ment emergente submitas.

El tipo de datos indica la clase de datos que espera recibir la columna
de la tabla de la base de datos (texto, numérico, valores booleanos de
casilla de verificacién). Por ejemplo, si la columna de la tabla sélo
acepta valores numeéricos, elija Numérico en el menl emergente
submitas.

Dicho menu incluye dos tipos de datos de Fecha. Seleccione el tipo de
datos Fecha MS Access para las bases de datos Microsoft Access y el
tipo Fecha para cualquier otra base de datos.

Repita el mismo procedimiento para cada objeto de formulario de la
lista Elementos de formulario.

8 Haga clic en OK.
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17 BUSQUEDA DE REGISTRO (QUERY ADAVANCED)

BuUsqueda de registros
Crearla pagina de busqueda

Una pagina de busqueda en la Web normalmente contiene campos de
formulario en los que los usuarios introducen pardmetros de
busqueda. Cuando el usuario hace clic en el boton Buscar del
formulario, se envian los parametros de busqueda a la pagina de
resultados residente en el servidor. La pagina de resultados residente
en el servidor, no la pagina de busqueda del navegador, es la
responsable de recuperar los registros de la base de datos.

Para comenzar con esta parte de la aplicaciéon Web, cree dos paginas:
una pagina de busqueda que permita a los usuarios introducir
parametros de bdasqueda y una pagina de resultados para mostrar los
registros encontrados. Puede incluso combinar las dos paginas en una
sola. Como minimo, la padgina de busqueda debe incluir un formulario
HTML con un boton Enviar.
Para afiadir un formulario HTML a una pagina de busqueda:

1 Abra la pagina de busqueda y seleccione Forms del panel insert de
clicenenel objeto form.

Se creara un formulario vacio en la pagina. Es posible que tenga que
activar los Elementos invisibles (View > visual aids > invisible
elements) para ver los limites del formulario, que se representan
mediante lineas delgadas de color rojo.

2 Aflada objetos de formulario para que los usuarios introduzcan sus
parametros de busqueda eligiendo Objetos de formulario del menu
Insertar.

Entre los objetos de formulario figuran los campos de texto, los mendas
de listas, las casillas de verificacion y los botones de opcion. Puede
afadir tantos objetos de formulario como desee para ayudar a los
usuarios a definir busquedas precisas. No obstante, recuerde que
cuanto mayor sea el numero de parametros de busqueda de la pagina
de busqueda, mas compleja serd la declaracion SQL.

Para obtener mas informacion sobre el inspector, consulte "Crear
formularios™, de Utilizacion de Dreamweaver o la Ayuda de
Dreamweaver (help >using Dreamweaver).

3 Ailada al formulario un boton Enviar (Insert > forms > Button).

4 Si lo desea, puede cambiar la etiqueta del boton Enviar

Instituto de Computacion Activa de México S. C. 70



MACROMEDIA DREAMWEAVER MX

seleccionando el boton, abriendo el panel de properties (Windows >
Properties) e introduciendo un nuevo valoren el cuadro Etiqueta.

Por ejemplo, este es el inspector de propiedades de un botén con la
etiqueta "buscar':

Bl DBl b & B i i Mg T Chaesdond £,
|_I Frirree TR [ rereeny a

A continuacion, debera indicar al formulario el lugar al que debe
enviar los parametros de busqueda cuando el usuario haga clic en el
botén Submit.

5 Seleccione el formulario eligiendo la etiqueta <form> en el selector
de etiquetas que se encuentra en la parte inferior de la ventana de

documento, como se muestra en la imagen.
<bady: <tabler <tre <bd: <Forme|<tabler <tre <td: <tabler <tr-
3

6 En el cuadro Accion del panel de properties del formulario,
introduzca el nombre del archivo de la pagina de resultados que
llevara a cabo la busqueda en la base de datos.

7 En el menu emergente méthod, elija uno de los siguientes métodos
para determinar como debe enviar los datos el formulario al servidor.

L]

GET envia los datos del formulario afadiéndolos al URL como una
cadena de consulta. Dado que los URL estan limitados a 8.192
caracteres, no utilice el método GET con formularios largos.

POST envia los datos del formulario en el cuerpo de un mensaje.

Default usa el método predeterminado del navegador (generalmente,
GET).

Ya ha terminado la pagina de busqueda. A continuacién debera crear
la pagina de resultados.

Una vez que el usuario introduzca los parametros de busqueda, la
aplicacion debera recuperar los registros de la base de datos. Esta
tarea la realiza la pagina de resultados.
Estas son las tareas que realiza una pagina de resultados:
+Obtiene los pardmetros de blusqueda de la pagina de busqueda.
s«Conecta con la base de datos y busca registros.

«Crea un juego de registros a partir de los registros encontrados.

sMuestra el contenido del juego de registros.

Si la pagina de resultados sélo tiene un pardmetro de busqueda (un
solo campo de texto, por ejemplo), podra crear la pagina de resultados
sin consultas ni variables SQL. Lo Unico que tendra que haceres crear
un juego de registros y después afiadir un filtro para excluir registros
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gque no cumplan las condiciones establecidas por los parametros de
busqueda enviados por la pagina de busqueda.

Si la pagina de busqueda envia mas de un paradmetro de busqueda al
servidor, debera escribir una consulta SQL para la pagina de
resultados y utilizar los pardmetros de busqueda en las variables SQL.

Después de que Dreamweaver inserte la consulta SQL en la paginay
gque se ejecute la paginaen el servidor, se comprueba cada registro de
la tabla de la base de datos. Si el campo especificado en un registro
cumple las condiciones de la consulta SQL, el registro se incluira en
un juego de registros. La consulta SQL crea un juego de registros que
contiene solamente los resultados de la busqueda.

Por ejemplo, el personal de ventas puede estar en condiciones de
informar sobre qué clientes de un &rea determinada tienen ingresos
superiores a un nivel concreto. En un formulario de una pagina de
busqueda, el asociado comercial introduce un area geografica y un
nivel de ingresos minimo y luego hace clic en el boton Enviar para
enviar los dos valores a un servidor. En el servidor, los valores se
pasan a la declaracion SQL de la pagina de resultados, que crea un
juego de registros so6lo con los clientes del area especificada con
ingresos superiores al nivel especificado.

18 MASTER DETAIL PAGE SET

‘_@w_ﬂjﬁ‘ . [
[ ENPLOYEE DIRECTORY DETAIL PAGE | =Discovering the werld

Bates, Chris

ALT, TEL | #1%-55d9-6732

START DATE | 1oy=iaz
DEPARTMENT | Operations
EXTENSION | =478
E-MAIL cheish@icarnpassiravel com

[ s |
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Una pagina maestra es una pagina en la que se listan los registros y
los correspondientes vinculos de cada registro. Cuando el usuario
hace clic en un vinculo, se abre una pagina detalle que muestra
informacion adicional sobre el registro. Por ejemplo, a continuacion
se muestra una pagina maestra de un sitio de Intranetde una empresa
ficticia:

Cuando un usuario hace clic en uno de los iconos de visualizacién
vinculados, se abre una pagina detalle:

Una pagina de resultados es un ejemplo tipico de pagina maestra. Sin
embargo, a diferencia de la pagina maestra descrita en este tema, la
lista de registros de una pagina de resultados la determina, no usted
como diseflador, sino el usuario. (El usuario determina la lista
mediante la realizacién de una busqueda en la base de datos.) Para
obtener mas informacidn sobre este tipo de pagina maestra.

Puede utilizarse una pagina detalle para actualizar o borrar el registro
mostrado. Para obtener mas informacion sobre la actualizacion y
eliminacién de paginas.

Una pagina maestra consta de los siguientes elementos:

«Un juego de registros.

«Una diagramacion de pagina para mostrar multiples registros.

+Un comportamiento de servidor Ir a pagina Detalle para abrir la
pagina detalle y pasar el ID del registro en el que ha hecho clic el
usuario.

Una pagina detalle consta de los siguientes elementos:

+Una diagramacion de pagina para mostrar un anico registro.

+Un juego de registros que contengan los datos del registro.

«Un filtro de juego de registros para recuperar un registro concreto de
la tabla de la base de datos o un comportamiento de servidor Mover a
un registro concreto para desplazarse a un registro concreto del juego
de registros

Tras afladir un juego de registros a una pagina maestra vacia, puede
completar el juego de paginas Maestro/ Detalle en una sola operacion
utilizando el objeto Live Juego de paginas Maestro/ Detalle. El objeto
Live afiade los siguientes elementos a la pdgina maestra:

sUna tabla basica con una region repetida para mostrar multiples
registros.

«Una barra de navegacion porel juego de registros.

«Un contador de registros.

+Un comportamiento de servidor Ir a pagina Detalle para abrir la
pagina detalle y pasar el ID del registro en el que ha hecho clic el
usuario.

El objeto Live también crea una pagina detalle si no la ha creado
anteriormente y aflade a ella los siguientes elementos:
«Una tabla bésica para mostrar un  0Gnico  registro.
«Un juego de registros filtrado para localizar y mostrar el registro en
el que el usuario ha hecho clic en la pagina maestra.
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Después de que el objeto Live coloque los elementos mencionados en
las paginas, podra utilizar las herramientas de disefio de paginas de
UltraDev para personalizar el disefio de las péginas o el panel
Comportamientos del servidor para editar los comportamientos del

servidor.

Para completar el juego de paginas Maestro/Detalle con un
objeto Live:
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1 Cree una pagina maestra vacia y afiada a ella un juego de registros.
Asegurese de que el juego de registros contiene, no so6lo todas las
columnas necesarias para la pagina maestra, sino también todas las
columnas necesarias para la pagina detalle.

2 Abra la pagina maestra en la vista de Disefio en el panel de insert
elija master detail page set.

Aparecerd el cuadro de dialogo Insertar juego de paginas Maestro/Detalle.

En el menld emergente recordset, asegurese de que esta elegido el juego
de registros que contiene los registros que desea visualizar en la pagina
maestra.

4 En el 4rea Master page field, seleccione las columnas del juego de
registros que deben visualizarse en la pagina maestra.

De forma predeterminada, Dreamwever selecciona todas las
columnas del juego de registros. Si el juego de registros contiene una
columna de clave exclusiva, como, por ejemplo, recordID,
seleccionela y haga clic en el boton de signo menos (-) para que no
aparezcaen la pagina.

5 Si desea cambiar el orden en el que aparecen las columnas en la
pagina maestra, seleccione una columna de la lista y haga clic en la
flecha arriba o abajo.

En la pagina maestra, las columnas del juego de registros estan
dispuestas horizontalmente en una tabla. Al hacer clic en la flecha
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arriba, se desplaza la columna hacia la izquierda; al hacer clic en la
flecha abajo, se desplaza la columna hacia la derecha.

6 En el menu emergente link to deatil from desde, elija la columna del
juego de registros que mostrara un valor que también servira como
vinculo con la pagina detalle.

Por ejemplo, si desea que cada nombre de producto de la pagina
maestra tenga un vinculo con la pagina detalle, elija la columna del
juego de registros que contiene los nombres de los productos.

7 En el menud emergente pass unique key, elija la columna del juego
de registros que contiene valores que identifican a los registros.
Normalmente, la columna elegida es la que contiene el nUmero de ID.
Este valor se pasa a la pagina detalle para que pueda identificar el
registro elegido por el usuario.

8 Especifique el nUmero de registros que deben mostrarse en la opcidn
de show.

9 En el cuadro Detail page Name, haga clic en Browse... y localice el
archivo de pagina detalle que ha creado o introduzca un nombre para
gue el objeto Live la cree automaticamente.

10 En el area Campos de pagina Detalle, seleccione las columnas que
deben visualizarse en la pagina detalle.

De forma predeterminada, Dreamweaver selecciona todas las
columnas del juego de registros de la pagina maestra. Si el juego de
registros contiene una columna de clave exclusiva, como, por
ejemplo, recordlID, seleccionela y haga clic en el botén de signo
menos (-) para que no aparezca en la pagina detalle.

11 Si desea cambiar el orden en el que aparecen las columnas en la
pagina detalle, seleccione una columna de la lista y haga clic en la
flecha arriba o abajo.

En la pagina detalle, las columnas del juego de registros estan
dispuestas verticalmente en una tabla. Al hacer clic en la flecha
arriba, se desplaza la columna hacia arriba; al hacer clic en la flecha
abajo, se desplaza la columna hacia abajo.

12 Haga clic en OK.

El objeto Live crea una pagina detalle (si no la ha creado usted antes) y
afiade contenido dindmico y comportamientos de servidor tanto a la
pagina maestracomo a la pagina detalle.

13 Personalice las paginas maestra y detalle para adaptarlas a sus
necesidades.

Puede personalizar totalmente el disefio de ambas paginas utilizando
las herramientas de disefio de paginas de Dreamweaver. También
puede editar los comportamientos de servidor haciendo doble clic en
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ellos en el panel Comportamientos del servidor.
19 RECORDSET NAVIGATION STATUS

El botén de recordset navigation status permite ver la posicion actual
de la p4dgina que tiene la base de datos.
Porejemplo

1 de 1 de 10, nos dice que estamos en el primer registro de 10 que
tenemos.

20 REPEAT REGION
]
Racordeet i F!.-:--:-:-r-:|5*::l:1 ll OF, I
Show: * |10 Racoeds at a Time Cancel
(™ Al Records Help

La opcion de repeat region permite especificar cuantas veces se
repetira laregion seleccionada de una conexion de base de datos.

21 LOGIN CONFIRM
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Log I Liser

it Input From Form: [forml

Lissname Fsid: [:e;tﬁe‘-:

Fleld,

Password Fiekd: [testfiess? Help

Yabclate Lising Connectin: [ﬁj

Table: [PRACTICA [E D

Uisername Column: |LELARED

Lol L] L]

Password Colusn: | CONTRASERA

[T o T Prevous LEL (F & eoists]
IF Login Fads, Go To: |

¥ Login Succeeds, 6o To: | Er-:m:-l.-|
Bronse. |

Restrict ficoess Based On: ™ Username and Password
™ Lkamame; Password, and Arosss Level
i5e Level From: |l 10 IZ|

Para establecer un login confirm debera tener tres hojas en modo de
vista disefio.
Para crear un login confirm siga las siguientes intrucciones

1.-realice suconexién a una base de datos (vease tipos de conexidn)
2.-cree un formulario con las siguientes nombres

introdusca un form

dentro del form escriba usuario, inserte un textfield

de nuevo dentro del form escriba contrasefia e introdusca un segundo
textfield

inserte un button

3.-seleccione el textfield de la etiqueta de contrasefiay en el panel de
properties seleccione pasword.

4.-vaya al panel de server behaviors presione le signo (+) y de la lista
desplegable seleccione user authentification > log in user aparecera
un cuadro de dialogo.

5.-verifique que los textfield apresan en forma odenada

6.- En el cuadro de Validate using connection presione la ventana
desplegable para seleccionar la base de datos.

En el campo if login succeeds, go to especifica pagina que se abrird en
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caso de que sea correcta la contrasena.
En campo de if login fails, go to:- especifica la pagina que se abriraen
caso de que la contrasefia sea erronea.

22 RESTRING PAGE

x
Festrict Resed Or; 5 bsmmiame snd Passwsond 1] 4 [
§ Listaraames, Pasewond, and Booess Lave Cancel |
Define.

Select Lol

e

IF &ccess Deried, Go To | |m]

Una vez terminado de crear pagina del usuario, abra el documento de
usuario o la pagina que va acceder el usuario en caso de que su
contrasefia sea correcta, en este documento lo vamos a restringir:
Para restringirel acceso a una pagina haga lo siguiente.

1.-abrael documento

2.-haga la conexion a la base de datos

3.-unavez hecha la conexién vaya al panel de application y presione
la pestafia que dice server behaviors

4.-presione el signo (+) del menu desplegable seleccione
authentification> Restrictacces to page,

en el cuadro de dialogo active la opcion que dice Restrict based on.
5.-enelcampo de ifaccess denied, go ot.

Especifique la pagina que se abrira.

23 REDIRECTION PAGE
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puedes redireccionar una pagina pasado un tiempo con las etiquetas
META.
ejemplo

<head>

<meta http-equiv="refresh”content="15;URL=www.ibm.com>
<title >pagina redireccionada a IBM a los 15 segundos <title>
</head>
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Cuestionario 7

1.- Concepto de:
Base de datos
Tabla
Campo
Registro

2.- Definicion de recordset

3.-Que es ODBC

4.- Utileria de Windows para configurar DNS de sistema

5.- Definicién entre DNS de sistemay DNSde usuario

6.- Que significa SQL

7.-Que es un formulario

8.- Definicién entre método POST y GET
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